
Dragon NaturallySpeaking 

Version 11

End-User Workbook



End-User Workbook (revision 1-9, March 2011) 

for Dragon NaturallySpeaking Version 11 

Most of the material in this workbook applies to all editions of Dragon NaturallySpeaking 11. For details about the different 
editions, please see www.nuance.com.

We welcome comments or questions about this workbook and all aspects of 
Dragon documentation (Tutorial, User Guide, Tip of the Day, Help menu, 
Accuracy Center, Performance Assistant, Sidebar, etc.) Please use the 
Feedback form at www.nuance.com/dragon/feature-request.  

This workbook reflects the Dragon 11.0 information available at the time of 
publishing. The Knowledge Base at nuance.com contains the latest 
information written by Technical Support for Version 11 and previous versions. 
The Support area of the website also includes printable documentation (User 
Guides, cheat sheets…) and listings of microphones, recorders, and other 
hardware tested by Nuance for use with Dragon.

The Nuance website offers many other resources, including tips, videos, 
Frequently Asked Questions, Customer Service information, and a feature 
matrix of Dragon’s editions.  

It also lists Value-Added Resellers who provide training and customization 
services for Dragon (in person or remotely). These Nuance partners can address 
your environment, equipment, goals and needs; this is particularly efficient for 
very busy people, people new to computers, children, and in case of issues 
with hearing, vision, mobility and dyslexia.    

No part of this document may be reproduced in any form or by any means, electronic or mechanical, including 

photocopying, recording, or by any information storage and retrieval systems, without the express written 
consent of Nuance Communications, Inc.

Nuance, the Nuance logos, the Dragon logos, Dragon NaturallySpeaking, NaturallySpeaking, DragonBar and 
Select-and-Say are trademarks or registered trademarks of Nuance Communications, Inc. or its affiliates in the 
United States and/or other countries. All other company names and product names referenced herein are the 
trademarks of their respective owners.

Part number: 50-K61A-15020



Copyright  2011  Nuance Communications, Inc. All rights reserved 3

Goals and Prerequisites

Dragon NaturallySpeaking lets you speak naturally to perform actions such as creating or editing 
documents, using e-mail, searching your computer, finding on the Internet maps, news, images, and 
more.  By reducing keyboard and mouse usage, you can gain productivity AND avoid strain on your 
wrists, shoulders, neck, and eyes. 

This workbook aims to efficiently present what an end-user should know — not every aspect of 
Dragon (the resources in Dragon’s Help menu and on www.nuance.com contain many details). It aims 
to help learn how to:

“Type by voice” naturally and efficiently, which includes:

Dictating anything (including prices, dates, phone numbers, URLs, symbols, punctuation, part 
numbers, acronyms, Roman numerals, etc.) 

Personalizing Dragon’s Vocabulary with custom words and phrases, spoken forms 
(pronunciations) and written forms, to ensure that it is able to transcribe exactly what you 
want, even if what you said could be written in different ways.

Correcting Dragon’s errors when needed so that the software can learn from them and avoid 
them in the future.

Formatting, editing, and revising text (however that text was created).

Creating custom commands to insert boilerplate content (commands of the type “Text-and-
Graphics,” available in editions Premium and higher).

“Command and control” your computer by voice, which includes:

Saying commands to use the Internet and e-mail, search your computer, open programs, click 

menus and buttons, close or minimize windows, switch between windows, etc. 

“Voice-pressing” a key (or key combination) on your keyboard.

Efficiency and Hands-Free Usage

We strongly recommend going through this workbook in order. If you used previous versions of 
Dragon, you may wish to read the What’s New section first. 

TIP  When directed to “click” items (buttons, menus, checkboxes…), feel free to instead use your 
voice, or keyboard shortcuts (underlined letters, Tab, spacebar…). If hands-free usage is important 
to you, start by reading the lesson Controlling the Operating System and Applications and see the 
Help about Dragon’s MouseGrid and commands for moving, clicking, and dragging the mouse.

To perform the exercises in this workbook, you should have basic familiarity with:

Using Microsoft® Windows® to start or exit applications, open or save files, maximize windows, close •
dialog boxes, copy or move items, browse to folders, cut and paste, etc.

Simple word-processing concepts such as bullets, font size and font style, bolding and italicizing, right-•
aligning and centering, etc.
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Creating a User Profile
Dragon NaturallySpeaking is speaker-dependent software. To recognize your speech accurately, it must have 
information including how you sound and what words you use often, as well as what optional settings you have 
and what audio device(s) you use. The data it uses to recognize what you say is stored in a set of files referred 
to collectively as your “user profile,” or “profile” for short. 

Your profile is very important; the more personalized it is, the better your experience will be. It’s worth 
creating it carefully (or upgrading it if eligible) so you can have the best possible start with Dragon, as 
described in this lesson. (As you will see later, there are many ways for your profile to be refined over time, 
and some of them don’t even require action on your part.)

Note: Profiles from Version 9 or 10 can be brought into Version 
11. Dragon’s Upgrade Wizard can automatically detect existing 
profiles. (It is available any time from the Windows Start menu, 

under Dragon NaturallySpeaking tools.) 

IMPORTANT: The Wizard will list ALL available profiles; use its 
Remove button as needed before clicking Next. After the 
upgrade completes, we recommend running Accuracy Tuning. 
See the Help for details.

A series of screens will walk you through the profile-creation process. This includes indicating your 

microphone’s type and verifying your sound system, as well as general training, an optional step where you 
read aloud for a few minutes so Dragon start adapting its acoustic model to the unique way you sound.

Here are important tips to help you achieve high accuracy right from the start.

Consistency matters! For best results, create your profile in your “normal” environment, with the same •
background noise and equipment as when you will usually do your dictations. 

If you want to test your microphone independently of Dragon, you can use Sound Recorder, a Windows •
accessory accessible from the Start menu (usually located at the bottom left corner of the screen).

If you already have a Dragon profile and want to use another type of audio input device, add a source •
to your profile instead of creating a separate profile. (Open the DragonBar’s Profile menu and choose 

“Add audio source to current User Profile.” Details are below.)

Step 1: Connect your microphone (all the way in) and position it correctly.  If using a 
headset, adjust its size so that it feels stable and comfortable (it should not 
press your glasses).  The microphone’s listening side must face the corner of 
your mouth (not the front) about an inch away.  It must not touch your hair or 
catch breathing sounds.  Bend the “boom” if needed.  You might experiment a 
bit to find what works best for you. When you use Dragon, aim for consistency 
in your microphone position!

IMPORTANT NOTES:

Noise-canceling microphones only listen on one side; check that your •
microphone’s listening side is parallel to your face, not tilted up. That 
side is often marked by a (raised) dot or the word TALK, which on some 

models is not visible unless you lift the foam cover slightly.
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If your model has a mute switch, make sure it is in the ON position!•

Some computers, after you connect a microphone, •
automatically bring up a small window associated with 

this “audio system event”.  That window may be hidden 
behind other windows. Before closing this window, verify 
that what is highlighted on it is the Microphone item (and 
not the Line In item). 

Step 2: Launch Dragon (you can double-click its desktop icon). If Dragon has never been used before on this 
computer, this automatically starts the Profile Creation Wizard (otherwise, choose New User Profile in 
the DragonBar’s Profile menu.)

Step 3: Answer the questions presented by the wizard’s screens. (No need to overthink the profile naming, but 
you may want to reflect the date or month of creation, for instance MJones-Oct2010). 

Since Dragon contains an acoustic model optimized for “young voices,” answering the age question can 

really improve your accuracy if you are under 13.
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Version 11 has special acoustic models for a number of broad “accents” (this is particularly important 
for natives of the UK or the Indian sub-continent). If unsure which one to pick, see the Help.

Step 5: You are asked to select your Dictation source. The default is a microphone plugged into the Mic-In 
jack. If you use a USB adapter on a standard headset, be sure to select USB. 

Note: If you use a docking station, you may get better results if you connect the microphone to the USB 
port on your laptop itself, not on the station.
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About dictation sources, including recorders

The Help provides details on using special dictation sources such as portable devices, and the Hardware 

Compatibility List on the Nuance website contains specific notes from Nuance’s testing, such as the 
recommended settings for specific recorder models. 

The Nuance website also contains resources on recorder usage. Recorders can be particularly useful to 
transcribe notes dictated after a meeting, class, or field inspection. If your recording was very “rough”, 
or if it contained voices other than yours, consider the practice of “echoing” (you dictate while 
listening to the recording, pausing it as needed). Dragon works with one voice at a time, so you cannot 
transcribe interviews or meetings directly.

Before using Dragon with a recorder, note that:

Some digital recorders come with special software to manage recordings (including transferring •
them from recorder to computer and converting their format if necessary.) Check your 
recorder’s documentation and install its software if required. 

You will want to be familiar with your recorder’s essential functions (starting and stopping •
recordings, for instance) and make sure the recorder is set with the correct time and date as 

well as optimal settings for speech recognition (see http://support.nuance.com/compatibility).

We recommend first using Dragon for real-time transcription because this gives you a chance to •
practice dictating (and punctuating!) your thoughts, since you get feedback in real time from 
what you see Dragon transcribe as you dictate. It also gives you the opportunity to personalize 
your profile, for instance by adding personal jargon or nicknames, and letting Dragon analyze 

representative text. This prevents many recognition errors. More on this important notion 
further in this workbook!

IMPORTANT: If you already have a Dragon profile and want to use another type of audio input 
device, add a source to your profile instead of creating a separate profile: open the DragonBar’s Profile 
menu and choose “Add audio source to current User Profile.”

This is important! Having sources within a 

profile enables the same Vocabulary to be 
used — and refined — each time you use 
Dragon, no matter which audio input 
device you use. (As you will learn, 
personalizing the Vocabulary early and 

often is one of the keys to getting Dragon’s 
full benefits.)

Step 6: Next, Dragon checks your audio system and 
calibrates the volume setting. Click “Start 
Volume Check” (at bottom left) and read 
aloud the text in the gray box in a clear but 
natural voice. Punctuation is not required 
here, but feel free to say it to get into the 
habit. 

When Dragon lets you know it has heard 
enough, click Next. The next screen is 
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similar; click its start button and read 
aloud. Dragon then verifies that your sound 
system is acceptable for speech 
recognition. (For details, see Help and the 
technotes at support.nuance.com.)

 

Step 7: If you did not choose to skip the initial training reading, Dragon then presents a prompt. Click Go, then 
say the short sentence displayed. When the “Select Text” box appears, choose one of the texts and 
click OK. (If you wish to read another text later, you can do so from the DragonBar’s Audio menu, or 

from the Accuracy Center.)

The following describes the default process, which presents the text one prompt at a time. The Help 
contains details on the “Without prompting” alternative, which presents the text as one whole 
document for you to read at your own pace, from the screen or from a printed page.

Step 8: Click the Go button (bottom left) and proceed through the training text by reading it exactly as it is 
displayed. (Once you finish reading a prompt, Dragon will automatically present the next one.) The 

words will turn gray once Dragon has “heard” them, but there is no need to wait for this to happen: 
just speak at your normal pace, clearly and naturally.

TIP: During acoustic training, Dragon learns how you sound when you dictate, therefore using the same tone, 
pace and volume you are likely to use day-to-day will help Dragon recognize your future dictations most 
accurately. 

Saying punctuation isn’t necessary during this reading, but it’s a good idea to say at least the periods, to get 
into the habit. (Later, you will learn to dictate all punctuation and symbols.)

Take your time. Try to read naturally but precisely what is on the screen.   

If Dragon needs to hear you re-read something, a 
yellow arrow will show you where to resume. 

The Redo button lets you move the arrow back, 
which you may want to do if you realize you just 
misread something.

If for any reason you have trouble with a 
particular word, use the Skip button. 

If you need to take a break, cough or sneeze, click 
the Pause button. That button will then be 
labeled Go; click it when ready to resume.

*

Once it has heard enough, Dragon takes a moment to process the acoustic information you just provided. 
Profile creation is now almost complete.
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A first opportunity to adapt your profile’s vocabulary

Dragon will then offer to start adapting its Vocabulary. This step is just a basic customization which analyzes 
the texts in your My Documents folder as well as your sent e-mails. Later, you will be able to designate specific 

documents for analysis; you do NOT need to copy documents into your My Documents folder in order to have 
Dragon analyze them!

Feel free to skip this basic step. We recommend that, as soon as possible after your profile is created, you take 
advantage of the powerful customization tools described in the following lessons. (For example, you can 
have Dragon analyze documents located in various folders, and you can import lists of custom words and 
phrases.)

IMPORTANT:  If some of your documents and sent emails are in a different language or in a radically 
different style, skip this automatic step and have Dragon learn from specific documents. 

Scheduling Dragon's periodic tasks

The Profile Creation Wizard will then give you the opportunity to schedule Dragon's periodic Accuracy Tuning, a 
process which, after you start using Dragon, can refine your profile automatically based on what you have 
already dictated. 

IMPORTANT: Be sure to schedule Dragon's tasks for a time when your computer will be on (not asleep, not 
hibernating) but Dragon is not be active (this includes being open in its QuickStart mode—see the Help for more 
information). 

For Accuracy Tuning, after you click the Change Schedule button, Dragon presents the dialog box Select Time 
and Frequency; be sure to also click this dialog’s Language Model tab, so you can pick a suitable time for the 
Language Model Optimization. (Note: Language Model Optimization is typically much faster than Acoustic 

Optimization.)
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Before your profile opens — caution with desktop icons

The last screen of the Profile Creation Wizard gives you the opportunity to jump straight to Dragon's Tutorial 
(clicking the Tutorial button on that last screen will close that screen and open the Tutorial). It also contains a 
link to the Help article about changes between 11 and previous versions (condensed and updated in the What’s 

New section of this workbook).

IMPORTANT: By default, the Dragon Sidebar (a thin window that presents commands and tips) is set to 
open automatically, docked to the right, when a user profile opens. If you typically keep desktop items on the 
right side of your screen, the Sidebar may move them, like other Windows sidebars would. For this reason, you 

may wish to rearrange your desktop items before the Sidebar opens, or set your desktop to Auto-arrange. (See 
the Sidebar’s Help, including Floating and Auto-Hide.)

This last screen of the Profile Creation Wizard also mentions Dragon's Options dialog, which we encourage you 
to explore as soon as possible so you can choose the settings that suit your needs and preferences. 

As you progress through this workbook’s lessons, you will be introduced to the options that most users should 

consider, in order to use Dragon as conveniently and efficiently as possible. Below are two of them: the Natural 
Language Commands built in for specific applications, and the Speed-versus-Accuracy slider.

Important options: Natural Language Commands and Speed vs. Accuracy

After you create your profile, the program may present you with a special message if it determined that your 

computer’s characteristics wouldn’t allow optimal performance. This message informs you that Dragon has 
adjusted the defaults for two of its options: 

The Speed versus Accuracy slider was moved toward speed.•

The Natural Language Commands for Microsoft Word, Excel, PowerPoint, and Corel WordPerfect ••••
were disabled. (The lesson “Controlling your Desktop and Applications” addresses these large sets of 
flexible commands. Note: not all editions and languages of Dragon support these commands.) 

Later, you can easily reverse these changes through Dragon’s Options dialog, depending on your particular 
needs: you can enable or disable the Natural Language Commands for any of these four applications 
individually, and you can experiment with various settings of the Speed-versus-Accuracy slider (seen in the 
picture below). The Help provides more details, and its Performance Assistant offers many suggestions for 
optimizing Dragon’s speed on your computer.
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Now that your user profile is created, you could start dictating. Before you do, however, we strongly 
recommend that you take a look at the Tutorial and, if you have used a previous version, the What’s New. 
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It’s also efficient to begin personalizing the Vocabulary as soon as possible, since this plays a crucial role in 
accuracy and efficiency—this workbook will cover its most important aspects.

Key points about getting started with Dragon 11

Each person who wants to dictate with Dragon first needs to have his or her own User profile. Creating �

one is a short process guided by a series of screens. Profiles from versions 10 and 9 can be upgraded to 

version 11 thanks to the Upgrade Wizard.

Make sure your microphone is properly connected and positioned, and the appropriate dictation source �

is selected. The online Help contains details on special sources like recorders and wireless 
microphones. 

In the higher editions of Dragon, you can add a dictation source to an existing profile (for instance, if �

after using Dragon with your USB microphone you wish to also have Dragon transcribe what you dictate 

into a digital recorder). Whatever source is used, you will benefit from the same vocabulary 
customization (special words and phrases, pronunciations, etc.) Starting with a regular source is 
recommended before you use Dragon with a recorder.

When reading the acoustic training text, speak clearly but naturally, using the same volume, pitch and �

pace you are likely to use day-to-day. Try to read what is prompted as if you were dictating it. Use the 
Pause button if you need to clear your throat or speak to someone… (When its microphone is on, 

Dragon listens to every sound coming from the microphone’s listening side!) 

During profile creation, Dragon can perform a basic adaptation of your profile’s vocabulary based on �

text it finds in your My Documents folder as well as on sent e-mails.  Feel free to skip that step but be 
sure to use Dragon’s more targeted and powerful tools as soon as possible after profile creation 
finishes.

Dragon's scheduled tasks are designed to help improve accuracy over time. Be sure to schedule them �

for a time when your computer will be on (not asleep or hibernating) but Dragon will not be running 
(this includes running in QuickStart mode). Please see the Help for more information.
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Learning More and Getting Help

Dragon NaturallySpeaking offers so many tools, commands, and features that it would be impossible to cover 
them all in detail in this workbook. This lesson presents several ways to find more information as you start 

using the software—be sure to take advantage of the available resources!

Note that we welcome comments about this user workbook and all aspects of Dragon’s documentation and user 
interface (User Guide, Tutorial, Tip of the Day, Help menu, Performance Assistant, Sidebar...). Please use the 
Feedback/Feature Request form at www.nuance.com/dragon/feature-request.  

IMPORTANT: By default, the Dragon Sidebar is set to open automatically when your user profile opens. If 
you typically keep many desktop items on the right side of your screen, know that the Sidebar may move them, 
like other Windows sidebars. Before the Sidebar opens, you may wish to rearrange your desktop items, or set 
your desktop to Auto-arrange.

The Dragon User's Guide

The latest User's Guide is available as a PDF on the Nuance website along with other resources. (When viewing 
the PDF file, you can click chapter headings to jump to specific topics, and you can print out sections as well as 
the entire file.)

The Accuracy Center and Accuracy Assistant

The most important features and tools of Dragon are accessible directly from the DragonBar's menus. The 
Accuracy Center offers a central location to access many of them and get guidance on which one to use when. 

Step 1: Say Open Accuracy Center. You can also click the DragonBar’s Help menu (or say Switch to DragonBar 
then Help or Click Help) then Improve my Accuracy.

Step 2:  Click the link that interests you. You can also say its name immediately preceded by the word "click”. 
("Require 'click' for HTML" is an option enabled by default in new Dragon 11 profiles. Enabling it helps prevent 
unintended recognitions. See the Commands tab of the Options dialog.) 

TIP  You can activate links without saying their whole name: for instance, instead of add a list of words to 
your vocabulary, you could say just add a list.

The link “Which tool to use first?” opens the Accuracy Assistant, which presents a set of questions to help 
determine what you can do to increase accuracy in a given situation. 

The Help and Performance Assistant

The DragonBar’s Help menu gives you access to the on-screen Help topics and the Performance Assistant (as 
well as the Accuracy Center, the Dragon Sidebar, the Tutorial, and the Nuance website.) You can also open the 
Help at any time by saying commands such as give me help.

You can browse the Help topics, or search for specific keywords—for instance, entering the word “punctuation” 
brings up topics including “Dictating punctuation and symbols” and “Selecting characters and words.”  You can 

also print topics of your choice.
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TIP:  To save time, you can use the command “search Dragon Help for…” naming the word(s) you wish to 
search for in the Help: for instance, you could say “search Dragon Help for punctuation and symbols”. Note 
that the words you name in this command will be considered individually unless you put them in quotes: for 
instance, you could say “Search Dragon Help for open-quote Firefox commands close-quote.” 

Dragon also provides contextual help: from its dialog boxes, the Help button or links take you directly to the 
relevant topic in the Help.

The Dragon Sidebar: “What Can I Say”

At any time, you can ask Dragon to display its Sidebar, a thin vertical window meant to help users discover and 
remember important tips and commands. When a major application such as Microsoft Word or Excel is active, 
this window will show in its Home tab commands for that application. Otherwise, it will show a list of 
commands that are not specific to one application. In addition, the Sidebar contains a hideable tab for mouse 
commands, as well as a tab for custom commands (a feature of the higher editions).

CAUTION: By default, the Dragon Sidebar is set to open automatically when your user profile opens. If you 
typically keep many desktop items on the right side of your screen, the Sidebar may move them, like other 
Windows sidebars; you may wish to rearrange your desktop items before the Sidebar opens, or set your desktop 
to Auto-arrange.

Step 1: Open the Dragon Sidebar. Voice commands for this include open Dragon Sidebar, show Dragon 
Sidebar, and what can I say. You can also use the DragonBar’s Help menu.

Step 2: The Sidebar opens, displaying some of the commands available in the current context, as well as tips. 
You can make it wider or thinner as well as access its links and tabs by hand or by voice. One way to 
access details about the Sidebar and its usage is to use the question mark icon on the top right of the 
Sidebar. (You can also say a search-keyword command such as “search Dragon Help for Sidebar 
commands.”) 

To access the tabs by voice, you can say “Dragon Sidebar Home,” “Dragon Sidebar Global,” “Dragon 
Sidebar MyCommands.”

TIP  To see commands beyond those presented in the Sidebar, you can use the Help (use the command 

“search Dragon Help for…” or the speakable links in the Sidebar itself) as well as the Command Browser, 

accessible from its icon on the top right of the Sidebar and commands such as Open Command Browser.                       
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Step 3: Right-click the Dragon Sidebar. This opens its menu. Note what is available there, including hiding the 
Mouse tab, hiding the Tips pane, activating Auto-Hide, and printing the content. 

TIP  When a Sidebar pane has the focus, a thin blue line surrounds it. 

The following illustrations show the Sidebar’s right-click menu, including the monitor switch, and its Mouse tab 
alongside a Help topic reached from the Sidebar link “Dragging the mouse.”
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Key points about learning more and getting help

This workbook is meant to get you started efficiently. Other resources include the Help, the Sidebar, �

the Accuracy Center and its Accuracy Assistant, the Performance Assistant, as well as the Nuance 

website which includes tips, FAQs, and the Knowledge Base of “Tech Notes”.

You can open the Help at any time with generic commands (give me help…) or “shortcut” commands �

that include the word(s) to search for, such as “search Dragon Help for Roman numerals…”

The Sidebar, which you can bring up through the Help menu or by direct voice commands, displays �

many commands and tips. You may use mouse or voice to access its panes, tabs, and links. Its right-
click menu gives access to options to change the display (including hiding the tips, hiding the Mouse 

tab, and auto-hide) as well as print its content. To see all its commands, use the Command Browser.

Beyond these resources, consulting an experienced Dragon trainer for specific guidance and customizations can 
be particularly efficient for users who have special environments, workflows, equipment, or challenges 
(related, for instance, to motion, vision, or speech fluency.)

Now that you know how to access many resources, let’s learn Dragon’s most important aspects, starting with 

with an often-overlooked but crucial one: personalizing the Vocabulary.
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Why Personalizing the Vocabulary is Important
Transcribing a person’s speech presents acoustic challenges, such as accent and ambient noise. There is also a 
lexical challenge: for the transcription to be precisely accurate, familiarity with the terms used is necessary.  
For instance, even an experienced medical secretary would have trouble transcribing for an attorney’s office! 
And a newly-hired transcriptionist would have to not only get used to the voices of the various dictators, but 

also to learn what spellings and formatting they want, including acronyms, abbreviations, special phrases, 
names of people, places, products, etc. 

An unusual name may seem commonplace to you because you use it frequently, but a person who hears it for 
the first time may not be able to spell it: that name is not yet a part of this person’s vocabulary. Similarly, if a 
word or phrase is not in Dragon’s active vocabulary, the software cannot transcribe it correctly without a little 
instruction.

When you created your User profile, you provided information which Dragon incorporated into its acoustic 
model.  To get optimal accuracy, you should also help the software adapt its language model and Vocabulary. 
Lexical customization ensures that what you dictate is transcribed with the desired spelling, spacing, and even 
capitalization; Dragon provides many powerful tools for it, so this important investment need not take much 
time.  The Help contains much information about personalizing the Vocabulary—including how you can even 
benefit from the customizations done by others. 

Key points about Vocabulary customization

As soon as you have created a User profile, you can start dictating, but note that taking a moment to �

start customizing the Vocabulary for you is a good investment to make right away, since it helps Dragon 
“get it right the first time” (including spelling, capitalization, and spacing) and it needn’t take much of 
your time.  Personalizing the Vocabulary early and often is strongly recommended.  The following 
pages will show you how.

Dragon offers many simple and powerful Vocabulary tools to allow you to make your dictations faster �

and more convenient. 
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Customizing the Vocabulary—Using the Vocabulary Editor
Dragon’s Vocabulary Editor lets you view what can be transcribed from the computer’s active memory; it also 
allows you to add new entries, as well as edit existing entries—including their Spoken Forms and Properties.

Let’s take a look inside the Vocabulary and discover the Vocabulary Editor’s interface:

Step 1: Say Edit Vocabulary (you can also use the DragonBar’s Vocabulary menu or the Accuracy Center). The 
Vocabulary Editor opens; its scrollable window lists the entries currently in Dragon’s active Vocabulary. 

Take a moment to scroll through the list. You will see names of people, places, institutions and 
products, as well as common words, phrases, and abbreviations. Most entries only have a Written Form 
(left column), but some also have at least one Spoken form — an important feature, as you will see.

 

Step 2: Open the Display drop-down list (located at the bottom) and choose Words Containing Spaces. Other 
Vocabulary displays include Words Containing Digits, Words Containing Capitalization, and Words with 

Special Properties. By browsing these, you can learn more about what the software uses to transcribe 
your dictation. You also get ideas about what entries you might add or edit.

Adding Vocabulary Entries: Words, Phrases, Acronyms…

You can quickly search for a particular Vocabulary entry by entering it in the Written Form field. If it appears 
in the scrollable list, it is already in the active layer of the Vocabulary. If not, say or click Add to bring it in.

CAUTION  When adding an entry to the Vocabulary, be sure to spell and capitalize it correctly! Otherwise, it 
will appear misspelled in your documents every time you dictate it.
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Some of the "words" in the Vocabulary Editor aren't single words. Of course is listed. So is as well as. There are 
also names of people, places, products, and institutions: Mother Teresa, Madison Square Garden, KitchenAid, 

Brigham and Women's Hospital, Marine Corps, Library of Congress, Babe Ruth, Accounts Payable, George 

Washington, Johnson & Johnson, Division I, LAN Server…  

These help the software resolve spelling and capitalization ambiguities: if the Vocabulary didn’t contain the 

phrase Mother Teresa, dictating it would probably produce the transcription "mother Theresa"—because the 
word mother is usually not capitalized, and because Theresa is the more common spelling of the name. Having 
the phrase in its Vocabulary helps Dragon know that the words “Mother” and “Teresa” are likely to occur 
together, and hence helps Dragon choose the desired capitalization and spelling.

Also, recognizing long sounds is easier than very short sounds. A and the are acoustically very similar, as are in 
and an. Longer words, like “chrysanthemum”, contain more acoustic information. 

We strongly recommend adding personal “multi-words”; this will later save you time since you will not have to 
adjust their spelling and capitalization after transcription. 

Exercise 1: In the Vocabulary Editor, search for a few familiar names such as your own first and last names, 
your town, company, colleagues or relatives; if necessary, add them using the Add button.  

TIP  When adding names of people, consider nicknames and diminutives as well as formal names, particularly 

for names that are very short or that can be spelled different ways: for instance, one might add Liz Hansen, 
Elizabeth McGee Hansen, Jennifer B. Addams, Jennifer Addams, Jenny Addams, Jenn Addams, Judge Addams, 
Scooter Addams…

This idea applies to more than just names. Whenever you add an item to the Vocabulary, think of its possible 
variations: singular/plural for nouns, present/past/gerund for verbs… Remember, if something is not in the 
Vocabulary, the software cannot recognize it, so don’t hesitate to add items even if you think you will not 
dictate them very often! 

Exercise 2: Open a word processor (such as DragonPad, available from the DragonBar’s Tools menu or from the 
command “open DragonPad”) and start a list of Vocabulary entries relevant to you; some suggestions 
are below. (Soon you will learn how to import these entries all at once.) 

jargon and phrases specific to your profession (such as distro, site visit and non-State)•

names of places, facilities or organizations (such as Building 52, or County Adoption Center)•

names of products (such as MicroPore tape or Latex Exterior Semi-Gloss) •

acronyms, part numbers, codes (such as FICA, 501c(3) or RX-70y)•

names of people (coworkers, clients, friends, relatives…) including full combinations for names •
that could be spelled differently (Kristin, Gene, Steven, McGregor, Wolfe…) or are very short (Kip, Kit, 
Dee…) since this helps Dragon resolve acoustic ambiguities.

TIP  If you are using Dragon for work, your employer may be able to give you some lists that could save you 
time, particularly if they are already in electronic form: lists of staff or clients, departments, units or divisions, 
products, trademarks, building names, as well as glossaries of terms and acronyms. Starting from such lists 
doesn’t just save time; it may also help add these items with their official, correct spelling! 
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The importance of Spoken Forms

Radio programs often tell their listeners “let us know how to pronounce your name” because some names could 
be pronounced in several ways and some are not pronounced “the way they are written” (due to silent letters, 
for instance). This is true for more than just names. Acronyms are often pronounced letter by letter, but not 

always: ASAP is pronounced "ay sap" by many people. These facts are addressed by an important Dragon 
feature: the Spoken Form.

From the Display drop-down list of the Vocabulary Editor, choose “Words with spoken forms only.” Take a 
moment to scroll through and look at existing spoken forms; you will get ideas for what kinds of entries warrant 
them and how they can be written.

 

TIP  Vocabulary entries may have more than one spoken form. You may add spoken forms to custom entries as 
well as to existing entries, in order to be able to dictate them as comes naturally to you: for example, to enter 
the symbol ©, you might like to say “circle see” instead of the existing spoken form “copyright sign.”

Spoken forms must not include punctuation, abbreviations, or symbols. Here are a few examples:

Written Form: The Man from U.N.C.L.E
Spoken Form: the man from uncle

Written Form: St. Clement's Hospital
Spoken Form: Saint Clements Hospital

Written Form: Soddy-Daisy, TN.
Spoken Form: Soddy Daisy Tennessee
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Written Form: Trenton-Mercer Airport
Spoken Form: Trenton Mercer Airport

Adding Spoken Forms allows you to dictate in the way that is most natural, but also quickest for you. In 
addition to indicating pronunciation, Spoken Forms can be used for “vocal shorthand” and automatic 
substitution: you say something short and easy, and Dragon types something longer or “trickier” to say (or to 
remember). You will many examples in this workbook. This capability can be used to give consistency and 

clarity to your writings; groups can take advantage of it to help everyone easily comply with recommendations 
like avoiding abbreviations and potentially confusable items. 

To add a Spoken Form in the Vocabulary Editor:

Step 1: First, decide what you want to say, and what Dragon should transcribe when you say it. For example, 
suppose Central Lexington United High School is often called CLUHS or "cluss". Do you want Dragon to 

type CLUHS or Central Lexington United High School?

Step 2: In the Written Form field, type what you want Dragon to write. Be careful with its capitalization, 
spacing, and spelling — including symbols or punctuation marks if needed, as in E*TRADE.

Step 3: In the Spoken Form field, type what you will actually say. In some cases (as in our “cluss” example), 
you will enter one or more “made-up words” to represent the desired sound. 

Step 4: Say Add or press Enter. (If you entered a “made-up word” in the Spoken Form field, Dragon brings up a 
dialog box to tell you that it doesn’t know that word and will therefore guess its pronunciation — this 
gives you a chance to catch any typo you may have made in the Spoken Form.) 

TIP  Entries containing symbols, digits, or unusual spacing are particularly likely to warrant a Spoken Form. If 
the written form of a word contains any punctuation, consider providing a spoken form so that there is no 
doubt as to how the item will be pronounced.  

If you add e-mail addresses to the Vocabulary, giving them a Spoken Form can make them quicker to dictate: 
for instance, “Amy and John at yahoo dot com” or even just “Amy and John at yahoo” for 
AmyT&JohnB@yahoo.com.
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Deleting “Words” and Modifying Word Properties

If you find that an item is not transcribed as you would like, remember that it might need a spoken form, or a 
longer entry in the Vocabulary, and that Dragon may need to learn information about how frequently you 
use it and next to what words, so it’s useful to let Dragon analyze relevant documents and sent emails, as 
well as to run the Accuracy Tuning process (see the Accuracy Center). Also, particularly if the pronunciation 
contains non-English sounds, you may want to help the software with some acoustic “training”—see "Training 
Words". 

You may also run into cases where a word you need is consistently transcribed as another word; if that other 
word is not important to you, deleting it from your profile’s active Vocabulary will solve the conflict by 
removing your desired word’s “competition.” For instance: the names Schaeffer, Shaffer, Schaefer and Shafer 

all sound alike, so if you want Dragon to write “Schaefer” but it typically writes “Shafer” even though you have 
already corrected the recognition error, you may want to delete “Shafer” from the Vocabulary.

You can do this by finding and deleting the word in the Vocabulary Editor, or you can do it by bringing up the 
Correction menu over the undesired word after Dragon transcribed it.

       

Note: Dragon’s active Vocabulary comes with literally thousands of entries; as you browse the Vocabulary 
Editor, you will see many you are very unlikely to ever dictate, but don’t spend time deleting them unless they 
actually cause a conflict!

TIP  There’s more you can do in the 
Vocabulary Editor! For instance, by 

clicking the Properties button, you can 
view or change the capitalization, 

spacing and numeral properties of an 
entry.

  

In the Word Properties dialog box, you 

can also choose one or even two 
alternate written forms. For example, 
you may prefer:

the spelling “email” over the 
hyphenated “e-mail”, 
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the ellipsis (…) to NOT trigger 
capitalization of the next word,

the word “figure” to be written as 
“fig.” when before numbers as in 
“fig. 3” for instance…  

IMPORTANT You would also use the Word Properties dialog for the dictation command “new line” if you 

want it to trigger capitalization of the following word. (See Starting to Dictate.) 

Your documentation provides more details; in particular, take a look at the Help topics “The Vocabulary Editor 
Dialog Box,” “Deleting words,” and “The Word Properties dialog box.”

Key points about the Vocabulary Editor

You can access the Vocabulary Editor with a command like edit vocabulary, through the Accuracy �

Center, or through the Vocabulary menu of the DragonBar. 

In the Vocabulary Editor, custom-added entries are marked with a red plus sign; choosing Custom ����

Words Only from the Display drop-down list allows you to see just the custom entries.

You can locate an item by entering it in the Written Form field. By using the Display drop-down list, �

you can also browse subsets like “Custom words only” and “Words containing punctuation.”  

Spoken Forms are an efficient way to help Dragon transcribe “special words.” You can view many �

examples of Spoken Forms in the Vocabulary Editor. In addition to clarifying pronunciation (particularly 
useful for items that contain digits, symbols, or silent letters), Spoken Forms can be used to allow the 
speaker to say something quite different, and much shorter and easier, than their associated written 
form: you say just “E O B stat”, for instance, and Dragon types “Explanation of Benefit (EOB) 
statement.” 

A Vocabulary entry can have several spoken forms, and can have one or two alternate written forms.�
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If a Vocabulary entry you don’t need “competes” for recognition with something you do need to �

dictate, you can delete that entry from the Vocabulary Editor (for instance, Cassidy and Cassity). To 
see the words that have been deleted from the vocabulary, you can choose “Deleted words only” from 
the Display drop-down list.

You can view or change the special Properties of Vocabulary entries, including spacing and �

capitalization; for instance, you may wish to change whether Dragon uses the spelling “email” or “e-
mail”, whether the ellipsis (…) and the “new line” dictation command trigger capitalization of the next 
word… 

In the Vocabulary Editor, entries whose properties were modified are marked with the letter P in a blue �

square.
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Importing Lists of Vocabulary Entries
You now know how to add words and phrases one by one in the Vocabulary Editor. If you have many entries to 
add, this is not the most efficient method, particularly if you already have some relevant lists in electronic 
form. Dragon’s Word Import feature allows adding many Vocabulary entries at once, even if they have Spoken 
Forms. 

Observe the sample import list in the illustration below, and identify the motivation behind each entry. You 
can then make and import one or more lists of your own, as described below.

To create and import lists of “words”:

Step 1: Create a document (or edit an existing document) listing entries you want to add to the Vocabulary. 
You can do it in any word processor as long as you can save this document as plain text.

Have each entry on a separate line. •
Make sure everything is spelled, capitalized and spaced correctly.•
To include a Spoken Form, follow the Written Form with two backslash characters then the Spoken •
Form: for example, Grb II\\grab two. 

Step 2: Save this document as a .txt file (from the File menu, choose Save As and, depending on the word 
processor, choose Text Document, Text Only, or Plain Text), then close the file.
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Repeat as necessary with other lists. (You may find it convenient to make several lists, such as a list of 
friends and relatives, a list of professional contacts, a list of product names, a list of local landmarks, 
etc.)

Step 3: Say import custom words, or use the DragonBar’s Vocabulary menu to pick “Import list of words or 
phrases.”

Step 4: On the Add Words from Word 

Lists dialog, click the Add File 
button. 

The Add File window appears. Locate the 
file containing your list and click Open; 
the name of the file you designated is 

now displayed in the File List.

If you have other lists to import, add 
their files in the same way.

Step 5: Click Next. The software will 
import the listed items into the 

Vocabulary.

The imported entries will be viewable in the Vocabulary Editor, where a red plus-sign appears next to them 
(like for entries that were added by means other than an import list).

Key points about importing Vocabulary lists:

You can add whole lists of Vocabulary entries at once. Prepare the list(s), then open Dragon’s list �

import dialog (you can say import words, or choose from the Accuracy Center or the DragonBar’s 
Vocabulary menu).

Word lists must be saved as plain text, and closed, before they can be imported.�

Each word list entry must be on its own line.�

To specify a spoken form in a word list, use two backslashes to separate it from the written form.�
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Customizing the Vocabulary from Existing Documents
You now know about importing lists of entries into the Vocabulary.  Another efficient way to boost your 
accuracy is to let Dragon analyze text that is similar to what you are likely to dictate: the Add Words From 

Documents tool use many documents at once to “harvest” potential words to add to the Vocabulary, as well as 
to “adapt to the writing style” (i.e., learn frequency information).  The greater the amount of relevant text 

Dragon gets to analyze, the better it can adapt its Vocabulary to what you usually need to dictate.  (This is 
similar to giving a just-hired transcriptionist many documents in which to observe the terms used, their 
spellings, the words that often appear before or after, etc.; doing so would help the transcriptionist get ready 
to transcribe your dictations most accurately, right from the start.)

Dragon can perform its text analysis on files of the following types: .txt (plain text), .rtf (Rich Text), .doc(x) 
(Microsoft Word), .wpd (Corel WordPerfect), and HTML formats.

TIP  If significant text exists only in an application that doesn’t normally produce files of these types 
(PowerPoint is an example), see whether this application lets you copy text so you can paste it in the 
DragonPad and save it from there, or whether it offers a way to extract plain text (it could be called “export” 
or “save as outline” for instance.)  Also, if essential text only exists as PDF or in paper form, consider using 
Optical Character Recognition software such as OmniPage to convert into one of the accepted formats.  

Step 1: Locate some electronic documents you have written—think of reports, letters, memos, proposals... (As 
long as they are similar to what you intend to dictate, you can also use documents written by someone 
else.) The more closely these documents match the dictation you will usually be doing, the better. 

Step 2: Spell-check the documents if necessary (since Dragon would detect misspellings as unknown words.) In 
addition, remove any foreign-language sections that might be present. Then, make sure the 
documents are closed. The Help contains more details on this tool, including how to best prepare 
documents for analysis. 

Now that you have a sample of text similar to your intended dictations, let’s designate this sample for 
analysis.  (If you obtain more documents later, you can designate them to Dragon later.)

Step 3: Say "switch to DragonBar", then "vocabulary" to open the menu, then "learn from specific 
documents."(There are other ways to do, by voice or by hand.)

Make sure that the box “Preview 
the list of unknown words” is 
checked, and click Next.

Checking the box “Adapt to 
writing style” will make Dragon 
learn frequency information, 
which increases accuracy since it 
helps differentiate between 
homophones like “world” and 
“whirled”.  Leave this box 
checked unless you only want to 

“harvest” potential custom words—
for instance, if the text is very 
different from your normal style, 
or contains a foreign language. 
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Step 4: On the Add Documents box, click Add Document. On the resulting window, locate and select the 
relevant document(s), then click Open.

TIP  You can select multiple files at once by holding 
down the Ctrl key or by pressing Ctrl A (the Windows 
keyboard shortcut to “select all”).

Dragon will now analyze the text contained in the designated documents. This may take a moment—if 
there is a lot of text to analyze, you should run this tool when you do NOT need to use Dragon for 

something else. Once Dragon indicates that the analysis is complete, click Next. 

Dragon will then present you with a list of the “unknown” words it found, with a checkbox next to each 
one, and the number of times each word was encountered (the words found most frequently are 
presented at the top since they are most likely to be relevant, unlike those that only occurred a few 
times.)

Step 5: Uncheck items you do NOT wish to add (using the Uncheck All button typically saves time). 

TIP  This list may include capitalized forms of common words; these are usually better left out of the 
Vocabulary since you can always say “cap” before a word, but you may want to include them in a 
phrase entry, such as ‘Senior Technical Trainer’ (remember, it’s a good idea to add to the Vocabulary 
the phrases you like to see capitalized).

If you wish to modify an item (to make it lowercase, or expand on it, for instance) or you wish to give 
a spoken form to an item, highlight it then click or say Edit. This button opens the Edit Word window, 
which also presents a little context for the item.
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Before the words are added, you are given the option to provide acoustic training for them. Feel free 
to take this opportunity to pronounce them, but know that you can skip this step and provide training 
later just for those words that seem to need it, as explained in this workbook and in the Help.

Finally, Dragon will adapt its word-frequency and context information based on the text analyzed (unless you 
unchecked the box “Adapt to writing style” on the first screen of this tool); this will allow it to better choose 

between words that sound alike. 

Key points about customizing the Vocabulary from documents:

Add Words From Documents is accessible from the DragonBar and Accuracy Center.�

This tool can analyze existing documents to learn about the “writing style” you plan to use—meaning, �

which words are used with what frequency, and what words appear near each other. You can also use 
as input documents written by someone else, as long as they are similar to what you will dictate. 

To be used in this tool, files must be text files (see the type list in the Add Document window).�

The tool can process many files at a time. You may wish to re-run it whenever you create or find �

suitable text. The more (relevant) text is processed, the more refined your profile can become. 

When presented with the unknown words the tool found in the texts, you can choose which ones to �

add, and, thanks to the Edit button, modify their spelling and capitalization as well as give them a 
Spoken Form if warranted.

After adding to the Vocabulary items you are likely to dictate, letting Dragon see how often and next to �

what you are likely to dictate them helps pre-empt recognition errors. 

Analyzing specific documents is only one of the ways Dragon can adapt; you can learn others in this �

workbook as well as in Dragon’s Help.
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Customizing the Vocabulary from Your E-Mail 
As you learned, Dragon can adapt its Vocabulary based on designated documents. It also has the ability to 
quickly learn from your usage of several e-mail programs: Lotus Notes, Microsoft Outlook, Outlook Express, and 
Windows Mail. By “studying” the e-mails you sent as well as the recipient names, Dragon can identify 
potentially useful contact names to add to the Vocabulary, as well as adapt its statistical information on word 

usage (frequency and context). 

You should take advantage of this tool as soon as possible after creating your User profile.

Step 1: Say open Accuracy Center, then say or click the link Increase accuracy from e-mail.

Step 2: The tool will detect supported e-mail programs installed on your computer and display their names 
(this may take a moment). Check the box of the e-mail program(s) you want Dragon to analyze here.

Step 3: Use the checkboxes to indicate whether you want Dragon to only look for contact names to potentially 

add to the Vocabulary, or whether you also want Dragon to adapt its statistics based on your sent mail. 

The option to “Improve from my 
e-mail writing style” will adapt 
the statistical language model; it 
is recommended EXCEPT if what 
you sent in that email program 
contains another language.

Note: 

The analysis may keep Dragon 
busy for a while, especially the 
first time; later on, it will go 
much faster if you choose the 

option button “Consider e-mail 

written since my last scan.”

IMPORTANT: When you start this process, your e-mail program may bring up a message box for you to 
allow Dragon to access it; if you have several windows open, this message may not be visible initially because it 
is under another window.

Step 4: After its analysis, the tool will display what it identified as potentially useful additions. 

The rest of the process is similar to the analysis of specific documents: you can uncheck items, edit 
items, and train items acoustically if you wish, then Dragon adds to the Vocabulary the checked items 
–plus adapts its language model to the word frequencies observed, if you opted for that.
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Key points about customizing the Vocabulary from e-mail:

Dragon can quickly adapt its Vocabulary from your use of e-mail in Lotus Notes, Microsoft Outlook, �

Outlook Express, or Windows Mail thanks to a tool available in its Vocabulary menu and Accuracy 
Center: Increase Accuracy From E-Mail.  

This tool performs two functions: it finds and lists potentially useful contact names to add, and it also �

analyzes your sent e-mails to “adapt to the writing style”, i.e. to refine the word usage information in 

the Vocabulary’s Language Model.

Use this tool as soon as possible, then launch it every so often so Dragon can learn from any new emails �

or contacts you have created. Remember that Dragon needs to “know about” your contacts in order to 
transcribe their name correctly—this is particularly important for Version 11’s shortcut commands such 
as “email that to…” and “schedule meeting with…” (supported in Microsoft Outlook). 
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Starting to Dictate: Controlling the Microphone
When ready to dictate, you must ensure that Dragon NaturallySpeaking is able to hear you. Your microphone 
must be connected and positioned correctly of course, but the software also needs to know whether to 
“listen”. This lesson shows several ways to turn Dragon’s microphone or on off, and introduces the DragonBar.

The DragonBar and the Microphone Icon  

In Version 11, the DragonBar appears by default docked to the top of the screen.  Be sure to explore, in the 
Options dialog’s View tab, the various ways that you can modify the DragonBar’s appearance to suit your 
preferences. 

If you choose “Floating”, the DragonBar will be narrower but thicker than when docked to top, and you can 

move it anywhere on your screen; to drag it, position your mouse over the DragonBar’s titlebar or over its 
“handle” (the gray vertical lines at left.) 

Right-clicking the DragonBar brings up its contextual menu. From there, you can say View options to open the 
Options dialog directly on its View tab, you can exit Dragon, and more.

TIP: Saying Show titlebar toggles the titlebar on or off. If you like the Floating display but want to save 
vertical space on your screen, you may wish to toggle off the DragonBar’s titlebar. 
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Note: If you set the DragonBar to "Always on top", it will cover secondary Dragon windows, such as the 
DragonPad and Help screens. For more details (including using voice commands to switch the DragonBar in and 
out of “Tray Icon only”), see the Help. Remember that you can quickly search Dragon 11’s Help by voice by 
naming one or more search words or phrases, as in, for instance: “search Dragon Help for DragonBar display.”
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The DragonBar includes several menus, a message area, and a microphone icon which is horizontal when the 
microphone is off. If you click this icon, it becomes vertical: the microphone is on. You can now click the icon 
to turn the microphone off. This is just one way to control whether Dragon can listen or not.

Below is a screenshot of the Floating DragonBar, with its titlebar off and the microphone turned on.

TIP  The microphone icon is also available in the system tray (on the Windows Taskbar, usually in the lower-
right near the time display). You may want to check that your operating system does not hide it among other 
icons. (The illustration below is from the Notification Area Icons section of the Control Panel in Windows 7.)

The Microphone’s Commands and Sleep State 

One can turn off the microphone by saying the command microphone off. There is no command to turn the 
microphone on given that, when the microphone is off, it can't “hear” anything! There are, however, 

commands to put the microphone in and out of a “sleeping” state where it doesn’t transcribe your words but it 
is still listening. To try this, turn the microphone on by clicking on its icon, then say stop listening or go to 
sleep.

IMPORTANT  For these and all voice commands, there should be a brief silence before and after, but 
none in the middle, otherwise the program cannot recognize the command and instead transcribes the words. 
For example, make sure you say the words “go to sleep” together in a natural flow, not “go… to… sleep”. 
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Putting the microphone to sleep is useful when you need to "put on hold" Dragon for a moment. However, 
leaving it in that state for a long time is not recommended, so do turn the microphone off if you will not be 
dictating for a while (and are physically able to turn on the microphone manually.) 

TIP  You can set Dragon to have the microphone asleep when your profile opens, waiting for your command to 
“wake up”, so that no manual action is needed to turn the microphone on. To set this option by voice, say 
“open Dragon options” then “Miscellaneous” then “Have the microphone on but asleep."

The Importance of Hot Keys, including Microphone On/Off

Pressing a key or two is usually quicker than moving and clicking the mouse (and physically easier, too)—
software programs, including operating systems, typically contain keyboard shortcuts, or ‘hot keys’. Dragon 
provides hot keys for various useful tasks, including controlling the state of its listening.

If your computer has a full-sized keyboard, press the plus (+) key on the numeric keypad (on the far right of 
the keyboard). Pressing this key turns the microphone on, and then pressing it again turns it off.

If your computer does not have a numeric keypad, or you wish to keep the plus key for other use, designate a 
new key to serve as the microphone on/off hot key. This is done through Dragon’s Options dialog box:

Step 1: On the DragonBar, click Tools, then Options (you can also say open options dialog). Click the tab 
labeled Hot Keys (you can also say Hot Keys).

Step 2: Click the button Microphone On/Off. A window 
entitled Set Hot Key appears.

Step 3: Press the desired key or key combination (F10 is 
typically a good choice), then say OK or press Enter. 

(If this key is already assigned in another 
application, Dragon will let you know.)

Step 4: You are back in the Options dialog box. Click Apply, then OK.

Note that Dragon also offers a hot key to toggle the microphone between sleep and listening.

Key points about controlling whether Dragon “listens”

Dragon “listens” whenever its microphone is on. Remember to turn the microphone off (or put it into �

its sleeping state if appropriate) when you are not dictating, like before answering the phone, speaking 
to someone, or clearing your throat; this is a simple but important habit you should develop quickly.  

Pressing its hot key is usually the fastest and most convenient way to turn the microphone on and off; �

you can also click the microphone icon on the DragonBar or in the System Tray. 

You can change any of Dragon’s default hot keys, including the microphone’s, in its Options dialog (say �

open options dialog, then hot keys). 
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You can turn the microphone off by saying microphone off, but then the mouse or keyboard need to be �

used to turn it back on. You can say go to sleep or stop listening to put the microphone into a sleeping 
state and then say wake up or listen to me when you wish to dictate again.

Microphone off, stop listening, go to sleep, listen to me and wake up are all voice commands. In �

order for Dragon to recognize and execute the desired action, you must pause slightly before and after 

but not in the middle of the command. 
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Starting to Dictate: Your First Dictation
You can use Dragon NaturallySpeaking to dictate into virtually any Windows application. Further in this 
workbook, you will learn how to start programs by voice (but one doesn’t need to have started a program by 
voice in order to dictate into it.)

What you dictate will be inserted wherever your insertion point (cursor) is located in your document. There are 

many ways of moving the insertion point by voice, but know that you can also re-position it by hand (clicking 
the mouse where you want it, or using your keyboard’s arrow keys) just as you normally would.

TIP  Before dictating, make sure the desired window is active (its title bar should not be dimmed), and the 
insertion point is where you want your dictation to appear. (Your operating system can make such visual 
elements easier to see; Windows XP’s Accessibility Wizard, under Start>Programs>Accessories, walks you 

through various items that can be helpful, such as increasing the thickness of the insertion point.) 

Dictating Text and Punctuation Marks

Here are the most common punctuation marks, followed by what you say to “voice-type” them: 

. period

, comma

? question mark

!      exclamation point or exclamation mark

:      colon

;      semi-colon

For these exercises, start a word processor (like DragonPad—say start DragonPad).

Exercise 1:  Look at the following sample, dictate it, then say microphone off. (If any word is misrecognized, 
ignore it for now.) The very first words may take a moment to appear on the screen; this is normal.

How is this different from dictating to a person? I should try to provide clean input: speaking 
naturally, but without mumbling or trailing off!

CAUTION  Do turn off your microphone when you finish dictating!  If your last sentence reads something 
like “trailing off! Microphone off", you probably forgot to pause briefly before giving the command.

New Line and New Paragraph

When typing, you use your Enter key to start a new line or new paragraph.  With Dragon active, you can still 
press your Enter key (or any other key on your keyboard), but you can also simply say commands like new line 
or new paragraph. 

Note: When you start dictating your new paragraph, Dragon will capitalize its first letter automatically, just 
like it automatically capitalizes after a period, an exclamation point, or a question mark. By default, Dragon 
does NOT capitalize the first word after you say the command new line.

TIP  If you prefer new line to trigger capitalization, you can change its default via the Vocabulary Editor, 
since new line belongs to a special group of commands accessible there; these so-called dictation commands, 

such as “Cap”, “Caps On” and “Numeral”, appear near the very top of the Vocabulary Editor’s list, with a 
blank Written Form field. To find them quickly, change the Display drop-down list to “Word with spoken forms 
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only”. Once you’ve highlighted new line in the Vocabulary Editor, say or click Properties, then choose 
“capitalized” from the drop-down list “Format the next word”. 

  

The Results Display and its Options

Exercise 2:  Study the following text sample then dictate it in a blank document. (Ignore any errors for now.)

The more I use it, the software will adapt to the way I sound and the words I use. At the same time, 
I will also acquire good habits like pausing optimally, keeping silent when hesitating, and turning the 

microphone off, or putting it into its sleep state, when necessary!

As you dictate, a small “rolling” Dragon icon appears, indicating that recognition is in progress.    

If the option “show preliminary results” is enabled (on the View tab of the Options dialog), you will instead see 
the following as in version 10 and prior:

Your words first appear in a small horizontal rectangle. This is called the Results Box. •

Words accumulate in the Results Box until you pause, at which point they appear in your document. If •
many words are dictated without a pause, the Results box automatically stretches out.

The contents of the Results Box sometimes change as you speak; what first appears there may not be •
what is inserted in your document, since Dragon sometimes revises its original guess based on 
subsequent words. 

Dragon uses the everything it hears between two pauses to best choose what exactly it should transcribe; this is 
particularly important for words that can be spelled in different ways, like “to” and “too”. If you speak single 
words, or only a few words at a time, the software has few or no contextual clues. For this reason, long 

continuous “utterances” can be recognized more accurately than short ones (and long words better than short 
ones). 

IMPORTANT  Try to formulate your sentences and commands before you start dictating them. This can be 
challenging at first, particularly for those who have been “thinking through their fingers” for years, but you’ll 

develop the habit once you see what a difference it makes.
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Exercise 3:  Dictate a paragraph of some four sentences on today’s weather. (For now, ignore any errors.)

Did you forget to dictate punctuation in this paragraph? It can be harder to remember when we are “composing 
out loud” but, with practice, it will become second nature. 

TIP  You can take advantage of Dragon’s option to automatically insert commas and periods as you dictate—
see Auto-Formatting under the DragonBar’s Tools menu. The Help contains details about this “Natural 
Punctuation” option and the commands to turn it on and off.

IMPORTANT: The location and behavior of the Results indicator can be customized from the Options 
dialog’s View tab. Many users find it most convenient to “anchor” the indicator to a place where it’s unlikely to 
hide anything, such as the bottom right corner of their screen; to do that, just check the “Anchor” checkbox, 
close the Options dialog, then drag the indicator to the desired place.

 

Below are other frequent punctuation marks—you may want to say them out loud once before the next 
exercise. Note in particular the ellipsis and the difference between dash and hyphen. 

Remember that you can use the Vocabulary Editor to see punctuation and symbols with their existing spoken 
forms, as well as to add your own spoken forms, and to modify properties (such as “having no following space” 
like the open quote.)

“ open quote

” close quote

( open paren or open parenthesis 

) close paren or close parenthesis

… ellipsis or dot dot dot

& ampersand or and sign

-- dash

- hyphen

TIP  You don’t always have to say hyphens: thanks to its built-in Vocabulary, Dragon can automatically 
include hyphens in items such as 3-year-old, above-mentioned, after-tax, ad-libbed, ankle-length, anti-
infective, as well as famous hyphenated names like Abdul-Jabbar. (To see many, you can choose “Words 
containing punctuation” in the Vocabulary Editor’s dropdown list “Display”.) 

You can prevent Dragon from entering a hyphen by pausing or saying “spacebar” where the hyphen would be.

Exercise 4:  Dictate the following sample (if any recognition errors occur, ignore them for now.)

These lessons remind me that "practice makes perfect."  (Who said this, Confucius?)  

When it comes to speech-recognition software, truer words were never spoken…

TIP  At the moment when one turns off its microphone off, Dragon may still be working on the last sounds it 
heard. Be patient—remember, this is an on/off toggle, so pressing the microphone hotkey again would actually 
tell Dragon to wake up. 
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Key points for your first dictation:

What you dictate is transcribed at the insertion point (the blinking vertical bar), the place where �

characters would appear if you started to type. (Before you dictate, make sure that the desired window 

is not just visible, but also has the focus.)

 To modify how Dragon indicates that recognition is in progress, use the View tab of the Options dialog �

(to bring up this dialog, you can say "open Dragon options). To avoid situations where the Results 
indicator (the little Dragon icon or the stretching box) prevents you from seeing something on your 
screen, you can "anchor" it (check the “Anchor” checkbox, then close the Options dialog and drag the 
indicator to the desired place). You can also change how long it remains on the screen. 

Speaking in longer, continuous phrases provides contextual clues and thus helps Dragon choose between �

homophones like “right” and “write” or “to” and “two”.

Punctuation is part of the dictation context—it has an impact on recognition accuracy.�

Two very frequent dictation commands are new paragraph (which creates a blank line) and new line. �

By default, new line does NOT trigger capitalization of the following word; you can change that �

through the Vocabulary Editor’s Properties dialog.

Your very first dictated words may take a moment to appear on the screen. This is normal.�
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Dictating Special Text: Numbers, Dates, Addresses, Units… 
As you saw in your first dictation, Dragon NaturallySpeaking automatically inserts spaces between words. It also 
follows spacing and capitalization rules: for example, it inserts a space after close quote but none after open 
quote, and it capitalizes at the beginning of sentences and paragraphs. 

In this lesson, you learn about contextual automatic formatting that allows you to naturally dictate prices, 

times, dates, abbreviations, contractions, units of measure, street addresses, e-mail addresses, URLs, ISO 
currency codes and other special text.  You also learn about Spell Mode and other recognition modes.

Automatic Text Formatting During Normal Dictation

On the Auto-Formatting Options dialog (available from the Tools menu), you can turn Dragon’s rules of 

automatic formatting off and on, as desired. For example, you can choose to have Dragon:

Transcribe numbers greater than two -
as numerals. (By default, Dragon 
follows the rule that small integers 
should be written as words unless in 
contexts such as a unit or address.) 

Use the drop-down list on this dialog.

automatically expand contractions -
(such as “won’t” and “didn’t”).

insert two spaces after periods. -

Please see the Help for details.

TIP   The Vocabulary Editor’s Word 

Properties dialog offers related capabilities. 
It lets you obtain contextual formatting: you 
can ask that numerals always be used after a 
particular word (as in “version 4”) and you 

can set alternate written forms (for 
instance, if you prefer “figure” to be written 
“Fig.” before numbers, as in “Fig. 3”). Note: 
The Vocabulary Editor also lets you change 
the properties of dictation commands (for 
instance, you may wish “new line” to trigger 
capitalization, as “new paragraph” does). 

Please see Vocabulary Customization.

Exercise 1:  Dictate some phone numbers, with and without area code; no need to say "hyphen".

Please call 607-585-3926 instead of 587-1239. Toll free directory: 1-800-555-1212  
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TIP  By default, Dragon applies its automatic formatting rules even if you pause within the segment (the 
option “Allow pauses in formatted phrases” lets you turn this off.) If you need to dictate sequences of 7, 10 
or 11 digits and do NOT want them formatted as phone numbers, one trick is to say “numeral” just before. 

Exercise 2:  Dictate the following address. For the line containing the zip code, just say Oakland California 9 1 
2 3 5; Dragon automatically uses the postal abbreviation for the state, and precedes it with a comma.

127 Evergreen Terrace

Oakland, CA 91235

Exercise 3:  Dictate the following dates.  (Dragon automatically formats when you say, for instance, “Monday 
July 16th 2009”.  

Tip: You can change the default date format to one of the many formats offered on the Auto-Formatting 
options dialog.

Monday, July 16, 2009 10/15/09 (say slash)   11-7-2013 (say hyphen)

Exercise 4:  Dictate the following sentence, or a similar one containing a price. Read the price as forty dollars 
and ninety cents; Dragon will automatically format it with the dollar sign and dot.

Suggested retail price: $40.90

Exercise 5:  Dictate the following sentence, or a similar one containing a URL. Pronounce the URL w w w dot 
the best business dot com. Dragon will automatically remove the spaces between words. 

Please visit www.thebestbusiness.com for more information.

Exercise 6: Dictate the following e-mail addresses. (Remember: for e-mail addresses you frequently dictate, 
adding them to your vocabulary will ensure that you can dictate them very quickly and with high accuracy.) 

Laura_Miller@aol.com (say “Laura underscore Miller” and “at” or “at sign”)

customerservice@electricalexperts.com (“customer service at sign electrical experts 
dot com”)

The Restricted Recognition Modes

There may be times when you wish to do a special kind of dictation, giving only commands, or only dictation, 
or entering many numbers or characters in a row—when inputting figures or product codes into a database, for 
instance. 

Version 11 of Dragon includes a persistent indication of the current recognition mode on the DragonBar (next to 
the Full Text Control checkmark).

Take a moment to explore Dragon’s restricted recognition modes, which include Numbers Mode, Spell Mode, 

Command Mode and Dictation Mode. (Please see the Help for details beyond the ones below.) 

TIP  Dictation Mode can be helpful if you want to dictate as quickly as possible.
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Numbers Mode -- Dictating Numbers Exclusively

When you are about to dictate a sequence of numeric data, consider switch on Dragon’s Numbers Mode. When 
in this mode, the software tries to recognize everything it hears as number-related (or as a command).

Step 1:  Say numbers mode on or choose Numbers Mode from the DragonBar’s Modes menu.  (Notice the status 
message in the DragonBar.)

Now that Dragon is in Numbers mode, you can:

dictate numbers and punctuation (hyphen, dollar sign…). For decimal point, say dot or point.•
say new line, new paragraph and space •
say move up|down|left|right <number> to move the focus in your document’s lines or cells.•

Step 2: To resume regular dictation, you can say a command such as switch to normal mode, or use the Modes 
menu.

Spell Mode -- Dictating Letters, Digits, and Other Characters

The Spell Mode is very useful for dictating character sequences which don’t form pronounceable words, as is 
often the case for part numbers, license plate numbers, codes… (It’s also useful for spelling out terms which 
you anticipate Dragon won’t know, such as words in a foreign language or unusual product names.)

Step 1: Say Spell Mode on or Switch to Spell Mode. The DragonBar will indicate that Spell Mode is on.

You can now dictate characters, including letters, digits, and symbols, as well as spacebar. •
To capitalize a letter, say cap immediately followed by the letter.•
As in Numbers Mode, you can use the move <direction> <number> commands to navigate, and say •
space. Dragon will not automatically add spaces as it usually does. 

You cannot use new line or new paragraph, but you can say press Enter.•

Step 2: You can return to normal dictating by voice (Spell Mode off…) or by hand (Modes menu> Normal Mode).
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TIP  The Help topic “Spelling Characters” contains the list of possible pronunciations, including the alpha-
bravo-charlie alphabet and accented characters like “n tilde” and “alpha umlaut”.  When spelling out, you can 
also say “oh” instead of “zero”.

The Spell Command -- Dictating characters within Normal Mode

IMPORTANT If you need to dictate a sequence of characters in the middle of normal dictation, the Spell 

command is usually faster than switching in and out of Spell mode: while in Normal Mode, you can say “spell” 
immediately followed by a sequence of characters (digits, letters, symbols, and space or spacebar). See the 
Help for details.

This can also be useful in cases where you want to put on the screen a word that would normally be interpreted 
as a symbol or a command. For instance, if you wanted to be sure that Dragon types the word “comma” instead 
of the punctuation, you could say “Spell space C O M M A”.

Exercise 7: Dictate “access code: 75Zq/7”, then practice with similar sequences of your choice.  (Pause briefly 
after the colon, then say “spell 7 5 cap zee cue slash 7”. Try to not pause at all during the sequence; if you 
paused, just resume by saying “spell” immediately followed by the rest of your sequence.) 

Key points about dictating numbers and special text

Dragon can format dates, times, prices, street addresses, phone numbers, Web addresses, units of �

measure, and other special text automatically. The Auto-Formatting options dialog (from the Tools 
menu) lets you turn these built-in rules off or on as desired.

The restricted recognition modes can make dictating special text more efficient. They are accessible �

by voice commands (“Numbers Mode on”, “switch to Normal Mode”) and through the DragonBar’s 
Modes menu. 

If you will be dictating only numbers and punctuation, consider turning Numbers Mode on.�

If dictating a long sequence of characters (letters, digits, punctuation, symbols), consider Spell Mode. �

(The Spell command is good for short sequences which you can say all at once, without pausing, such as 
“spell T W O”.)

When spelling out, you can insert a capital letter by saying cap just before the letter, and you can say �

space or spacebar.
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Correcting Dragon’s Errors in Your Dictated Text
Human beings sometimes can’t recognize words correctly—especially if the speaker and the listener come from 
different regions, if the speaker is discussing an unfamiliar subject, or if the words are not well articulated.  In 
addition, when we hear a word for the first time, we may not know how to spell it. Some people’s first or last 
names can be spelled different ways (like Gene/Jean, Hansen/Hanson). We often must verify how a person 

spells his or her name. 

This is also true for Dragon! The software uses contextual clues and statistical information to guess what to 
transcribe, but sometimes cannot guess correctly. In particular, it may not recognize uncommon words on the 
first try, and instead types something that was likely according to its statistics. It cannot recognize and 
transcribe a word it has never seen.

Fortunately, in addition to optimizing acoustic factors, taking advantage of the vocabulary customization tools 

and using proper correction techniques will significantly reduce the number of errors. Dragon’s Help contains 
many details about the different ways to perform it, including by keyboard.

You can choose when to perform corrections. If you look at your screen while dictating and you notice that 
Dragon just got a word wrong, it's usually best to finish your train of thought before you correct that 
misrecognition: you may want to at least finish your paragraph. That being said, if the misrecognition affects a 
word which is likely to appear many times in your document, it's a good idea to correct it as soon as possible.

TIP: Be sure to take advantage of how Dragon 11 lets you directly address a specific word or phrase in your 
text. When you give a command such as “correct <xyz>” (<xyz> representing the word or phrase you wish to 

correct) and Dragon finds several matches for “xyz”, Dragon will place a small number next to each match, so 
you can say the number of the desired one; if you wish to affect all matches at once, you can say “choose all”. 
(If you want the numbers to go away, you can say “cancel”, click our mouse, or just keep dictating.) Also, you 
may want to explore your application’s capabilities for replacing, including specific capitalization (the 
illustration below is from Microsoft Word 2010).

IMPORTANT: In Dragon’s commands, <xyz> represents the relevant segment on the screen (which could be 
one or more words, and could include numbers or punctuation marks). When you give the ‘correct <xyz>’ 
command, be sure to say what appears on the screen, not what you had intended.
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Note that when performing a correction, it can be useful to provide some context for the word(s) in error: for 
instance, to correct "a" in "sent a request," you may want to say “correct sent a” or "correct sent a request."

The Correction Menu

By default, when you say a command starting with the word "correct,” Dragon brings up the Correction Menu, 
which lists alternative transcriptions. (In the example illustrated below, the speaker said “correct Madison.”)

If what you had said is in the list of choices, •
you can pick it by voice (say "choose" followed 
by the number of the desired choice) or by 
hand (clicking on the desired choice, or using 

the down arrow).

If it is not, you can click or say "spell that" •
which opens the Spelling Window. There, you 

can indicate the correct transcription using 
voice, keyboard, mouse, or a combination.

(Note that the last item on the Correction menu gives 
you direct access to the Options dialog’s Correction 
tab. By default, the Correction menu also appears 
when you use the command “select <xyz>”)

Correcting in the Spelling Window

Some users prefer the Spelling Window to be the 
default interface for Correction, in order to be able to 
act directly if Dragon doesn’t show their desired 
transcription in its choice list (instead of having to use 
“spell that” from the Correction menu). 

This requires making changing one of the options on 

the Correction tab of Dragon’s Options dialog. Here is 
one way to do this: say “open Dragon options”, then 
say “Correct commands bring up Spelling Window” 
(or click that option’s checkbox).

With this option set, saying commands that start with 
“correct” opens the Spelling Window. (So do the 

Correction button on the expanded DragonBar and the 
Correction hotkey—the numeric minus by default). 

As you will see, there are many ways to indicate in 
the Spelling Window what should have been 
recognized—including spelling out individual 

characters, hence the name “Spelling Window.”
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Here is an example.  Let’s say you dictated "contact person colon Madyssen" but Dragon wrote “medicine” instead 
of the name “Madyssen”. To correct Dragon’s error, you can say correct medicine.

The Spelling Window opens. At its top is what was transcribed, 
and below is a list of alternate transcriptions, each preceded 

by a number. 

Here is what you can do:

If what should have been transcribed IS among the choices: 

say choose n (the number of the correct line). You can also 
pick the correct choice by double-clicking it or using your 

keyboard’s down arrow and Enter key.

If no choice is quite correct but one is close, you can save time 
by modifying it instead of entering it yourself: click it, or say 
modify n or edit n. In our example, you could say “edit 1” to 
bring up “Madison”, then “backspace 4” then “Y S S E N”. (See 

tips below.)

If what should have been transcribed is NOT listed:

enter it, then say OK (or click OK or press Enter). In our 
example, you could say “cap M A D Y S S E N” then “OK”.

The Spelling Window then closes and, in your text, Dragon replaces the misrecognized segment with what you 
indicated was the correct transcription. 

Note: In addition to adjusting your document, Dragon also learned a bit of information to refine your profile, 

and if you entered in the Spelling Window a word that was not in its active vocabulary, Dragon has now added 
that word to its active vocabulary (you could now see that word in the Vocabulary Editor).

Remember that Dragon allows the use of voice but does not prohibit the use of hands; at different times one 
may be quicker or easier than the other. In the edit line of the Spelling Window, it can be faster to make 
modifications with mouse or keyboard; however you can perform correction entirely by voice. 

You cannot dictate words in the Spelling Window. However, you can dictate: 

Individual characters: letters, digits, space, symbols (see your documentation for details)•
Commands like “backspace 5”, “move right 4 characters”, “delete next word”, “select line”•

As you enter characters, Dragon presents new choices in the list, so you may not have to enter all characters!

TIPS for spelling out: 



Copyright  2011  Nuance Communications, Inc. All rights reserved 51

To spell a capital letter, just say “cap” followed by the letter.•
You can use alternate pronunciations to spell letters: “alpha”, “letter alpha”, “letter a”, “bravo”, •
“charlie”, “delta”, “echo”, “foxtrot”, etc. (see the Help for the full list)

To insert a space, say “space” or "spacebar".•
If one of the choices listed is close, you can save time by modifying it: say modify and its number, •
which brings it to the top of the Spelling window.

Exercise 1:  Look at the following sample, dictate it, then use the correct <xyz> command to fix any errors. 
(Of course, this sample was designed to create errors! All the first and last names here could be spelled in 
different ways.) 

Until further notice, the BHDP meeting will be held in room B31 (not B40). 

Special invitees this week: Stephen Hess, Anne Petersen, and Gene Wood.

TIP  If several consecutive words are incorrect, correct them together.  For instance, if "B40” were recognized 
as "before tea,” you would say correct before tea.

Exercise 2:  Dictate uncommon words, such as nicknames or product names, until a few misrecognitions 
appear. Use the Spelling Window and practice spelling out what you actually said, as well as editing from the 

list.

TIP  In the Spelling Window, Backspace and Delete commands should be used instead of scratch that, 
especially if Press Key commands are used.

Using Playback to Aid Correction

Sometimes, especially if you dictate a significant amount of text before correcting, you may not remember 
exactly what you actually said. Dragon’s playback feature is very helpful in these instances. You can take 
advantage of it in several ways.

If you see that a certain word or phrase appears incorrectly, use the correct command to open the Spelling 
Window. Once it appears, click or say Play Back to hear the recording of your voice as you dictated that text. 
It may be that in fact you had misspoken or mumbled; this happens to everyone, particularly near the end of 
the day! In that case, close the Spelling window (you can say click cancel) and dictate the word(s) again.

TIP   You can have playback occur automatically with Correction. On the Correction tab of the Options dialog, 
check Automatic Playback on Correction. This is particularly helpful as you first learn to use Dragon; you may 
want to turn it off after a few weeks of practice.

You can also use the playback to hear sections of dictation in the document itself (if your edition of Dragon 
supports this feature). To do this, select the editable text you would like to hear played back. Then, say play 
that back, or use the DragonBar’s Audio menu. If you find a misrecognition, you can stop playback by clicking 
the mouse. (Since speech input cannot be received during playback, you cannot stop playback by voice. If 

clicking the mouse is problematic for you, play small selections at a time.)

Note: You may wish to explore the Playback attributes in the Options dialog.
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The DragonBar can be expanded (click its chevron or say view extras bar; to hide the extras bar, say hide 
extras or click the chevron again). Its extras bar gives access to several items (depending on your edition): 

The Correction button opens the correction interface (as do the Correction commands and hot key). •

The playback icons, similar to those on a music player, allow you to begin playback, speed up playback •
(useful for large sections of text), stop playback, and skip backwards or forward.

The Transcribe button launches the transcription of recorded files (see the documentation for details •
on transcribing spoken-word recordings, including using the Auto-Transcribe Folder Agent).

Exercise 3:  Dictate a detailed paragraph about the people you speak to most often. Then select it and play it 
back. If you find any misrecognitions, use the Correction button, hotkey, or commands to correct them.

Key points about correcting recognition errors

Refining your profile using the features gathered in the Accuracy Center can prevent many �

recognitions errors, since it will help Dragon be more familiar with how you sound and what words 
you use. Be sure to explore the Vocabulary Editor and let Dragon analyze relevant documents, for 
instance.

Although correcting misrecognitions can seem time-consuming at first, it will result in increased �

accuracy, which in turn means that there will be fewer and fewer misrecognitions to address. 

To use the second method described in this lesson, the option "Correct" Commands Bring Up ����

Spelling Window must be enabled. 

Flow matters: do not pause at all between ‘correct’ and the misrecognized word(s).�

When the Spelling Window is open, you can say choose n to pick the correct choice from the list. If �

no choice is quite correct but one is close, you can quickly modify it: click it once or say edit and 
its number (for instance edit 5), which brings it to the top of the Spelling Window, where you can 
edit it by hand or by voice.
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If the word(s) you dictated are not in the Spelling Window’s list of choices, you can spell them or �

type them. You cannot dictate words directly in the Spelling Window. 

To be sure of what exactly was said, click or say play back.�

To proofread using playback, first highlight the relevant text, then say play that back, use the �

DragonBar’s Audio menu, or click the playback icon on the DragonBar’s Extras bar.
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Deferring Correction
You know now that correcting recognition errors helps Dragon NaturallySpeaking adapt to your speech and 
recognize it more accurately. However, sometimes, you may not have time to correct errors before closing the 
document you dictated; if you dictate in DragonPad, Microsoft Word or Corel WordPerfect, the opportunity to 
correct misrecognition is not lost: Dragon can save what it heard in synchronization with the text you dictated, 

so you can later play it back and make corrections as needed. 

This “Deferred Correction” feature also allows you to let someone else correct misrecognitions in your dictated 
documents—which means your profile gets refined without any effort on your part.

Saving Recorded Dictation (.DRA)

Step 1: Dictate into DragonPad, Microsoft Word or Corel WordPerfect. (If you wish to make any corrections 
now, do so.) When you are finished dictating, save the document as you normally would.

Step 2: Dragon asks whether you want to save the associated recording. (Your word-processor’s Auto-Save 
feature may even trigger this message earlier). If you or someone else will be Correcting in this 
document later, choose Yes. 

Dragon will automatically save, in the same location as your text document, a file bearing the same name, with 

the extension .DRA. 

You may now exit the word processor and Dragon if you wish, even shut down the computer.

TIP  By default, whenever a word-processor document is saved, Dragon asks whether you want to save the 
recording; in the Options dialog, you can change that setting to always save, or on the contrary, never save. 

Recorded dictation files can get very large, so you should only save them if Correction is to take place at a 
later time; without the recorded dictation, you can still edit and format the document as usual.

Step 3: When you are ready to correct misrecognitions, start the application in which you dictated the 
document and open the document. You can now correct recognition errors. Select some text anywhere 
in the document and play them back. As you can see, the audio is still associated with your text. 

Once finished correcting misrecognitions in your document, you may delete the associated .DRA file. (You will 

no longer be able to use playback on this document but you will still be able to edit and format.) 

IMPORTANT  When using a .dra file, it is best to proceed in order, from the top of the document.

One of the services an experience Dragon trainer can provide is establishing optimal options and workflows, 
including the management of .dra files, particularly if another person will be your “Correctionist.” (See the 
Correction Only option available in the higher edition.)

Making Corrections to Someone Else's Dictation

As you have learned, correcting misrecognitions helps ensure that your accuracy increases. However, especially 
at first, and depending on the quality of the dictation, Correction can be time-consuming. 

The Save Recorded Dictation feature allows you to have someone else perform this important task for you. 
There are several ways to take advantage of it, particularly if the Roaming User feature is used—details are 
available in the online Help and IT Administrator’s Guide. 
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The following is an example of third-party correction: Jane has tasked her assistant, Bob, with performing 
Correction on her dictated documents, using his own computer. 

IMPORTANT: The dictator’s profile must be accessible from both computers. Copying profiles onto 
another computer is easy, but if the profiles are in a Roaming configuration, it is not necessary: their Master 

copy resides on the network, making them usable from any connected computer.

Step 1: Jane dictates her reports. When she is finished, she saves the documents to a network location Bob can 
access from his computer. When Dragon asks whether she wants to save the audio, she chooses Yes. If 
she wishes, she can now exit Dragon and/or her word processor, and shut down her computer.

Step 2: On his own computer, Bob starts Dragon; when prompted to open a User profile, he chooses Jane's.

Step 3: Bob starts the word processor Jane used, and opens the first report. He is now ready to perform 
Correction in this document.

Step 4: Starting from the top, Bob looks for “abnormal” text and highlights it manually. On the expanded 
DragonBar, he clicks the Playback icon (Bob should NOT use his voice here.) 

Step 5: Watching the screen, Bob listens and as soon as he hears an error, he clicks the Correction button or 
presses the Correction hot key, which brings up the Spell dialog.

If not quite sure of what Jane actually said, he clicks Play Back to hear her recorded voice. If the input 

is not “clean” (people sometimes make unintended sounds, stumble on a word…), he clicks Cancel and 
deletes the mis-spoken segment in the document before typing what was intended. 

If the correct alternate appears in the choice list, he clicks it with his mouse then clicks OK.

If the correct choice does not appear in the list, he types it in, then clicks OK or presses Enter.

When he has finished checking the document (and made any cosmetic modifications as warranted), Bob saves 
it. Now not only is the document finalized, but Jane’s profile has been refined through the corrections 

performed, which will help the accuracy of her future dictation. 

The following is only necessary if Roaming is not used: Bob exports Jane’s profile to the network (through the 
Manage User Profiles dialog); from there, Jane can import her newly-refined profile. 

Key points about deferred correction

When you dictate in Word, WordPerfect or DragonPad, Dragon can save the recording associated �

with your text so misrecognitions can be corrected later, as if you had just dictated it.

If you choose to save your recorded dictation, you can use Correction and Playback features later: �

simply start the word-processor in which you dictated the document, then open the document.

You can postpone Correction, or delegate it to a third party—your assistant, for instance.�

When saving your document’s recording, Dragon creates a file in the same directory as your text �

document; both files have the same name, but the synchronized recording has the extension .dra.

Dictation files can get very large, so only save them if necessary. Also, when you are finished �

making corrections to a document, you may wish to delete the associated .dra file; you will still be 
able to edit the document normally, and you will save disk space.
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The “Correctionist” must open the speaker’s profile but not speak into it. One can bring up the �

Correction interface by clicking the DragonBar’s Correction button or pressing the Correction 
hotkey (by default, the minus key on the numeric keypad).

To be used for Correction, the .dra file must be in the same folder as the document itself. �
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Editing Text by Voice
Dragon NaturallySpeaking lets you use your voice to move around within a document and edit the contents—
whether or not that document was originally created by voice. As you learned, the software transcribes your 
dictation wherever the insertion point is (usually shown as a thin blinking vertical bar some call cursor.)

This lesson presents some of the commands to select text and move the insertion point.  Mouse and keyboard 

can still be used, of course. Don’t try to do everything by voice unless you have to; at first, focus on getting 
optimal accuracy in your dictations — speaking clearly, adapting the vocabulary, performing corrections as 
needed… 

IMPORTANT: When you give a command like “delete <xyz>” or “select <xyz>” and Dragon 11 finds 
multiple matches for the <xyz> word or phrase in your document, the software lets you handle that ambiguity 

and even take advantage of it. It shows a number next to each visible match, so you can say the desired 
number or (for commands that can apply it) say “choose all.” (The message area of the DragonBar offers a 
reminder of this instruction when the numbers are displayed.)

Navigation and Selection Commands

TIP  Navigation commands use the words go and move interchangeably, and a space counts as one character.

Some commands move the insertion point regardless of its starting location:

move to top, or go to start of document –- moves to the beginning of the document

move to bottom –- moves to the end of the document

Other commands move the insertion point relative to its present location:

                        move to end of line (the current line, the one containing the insertion point)

move up(down) 1-20  line(s) or paragraph(s) –- e.g. move up 3 lines

move left(back) 1-20  word(s) or character(s) –- e.g. move left 7 words

move right(forward) 1-20 word(s) or character(s) –- e.g. move forward 3 characters

The insert commands position the insertion point just before or just after a specific word or punctuation mark:

insert before your office –- moves the insertion point to just before the phrase "your office"

insert after Joe comma -– moves to just after the comma following the word “Joe”
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The select commands let you “highlight” editable text visible on the screen. Below are just some of them. 

You can say select followed by what you wish to highlight (include punctuation as needed):

select next 2 words select let me know select comma obviously comma

 

Very useful for longer phrases, you can specify a range by naming its beginning and ending word(s):

select do let THROUGH convenience – "do let me know at your earliest convenience"

You can select one or more characters, words, lines or paragraphs at a time: select line, select previous 3 
paragraphs, select previous 5 words, select next character…

You can also select the entire content of the field or document: select all.

You can “unselect” a selection by saying unselect that or deselect that. (Another way is to move the insertion 
point with a move right command, for instance.) 

TIP  As with all commands, you must say these as a continuous phrase, with a brief pause before and after. 
For commands that quote words from your screen, choose your target words before you start to say the 
command. Otherwise, any hesitation will cause the words of the command to be typed on the screen. (If this 

happens, just say scratch that and try again, without pausing this time.)

One should always strive to dictate in complete phrases, since context helps the recognition of text. When it 
comes to commands, formulating the whole phrase and dictating it without pauses isn’t just helpful, it’s 
essential. The exercises below will provide plenty of practice. 

Direct Editing: Bold|Underline|Italicize|Capitalize|Copy|Delete|Cut… 

Dragon lets you perform frequent editing tasks quickly: like you can quote from editable text in the commands 
select <xyz> and select <start> thru <end>, you can say the verbs bold, underline, italicize as well as 
capitalize, immediately followed by the desired word(s). This “Quick Voice Formatting” also applies to copy, 
as well as delete and cut—these three can be disabled under Options.

IMPORTANT: If these commands are enabled, Dragon will try to recognize as one of them any phrase 
starting with one of these verbs followed by a word (or words) present in the text: e.g. “bold measures” or 
“cut corners.” Since Dragon recognizes commands only if they are spoken as one flow between two pauses, this 
won’t happen if the phrase is within a sentence or if one pauses within the phrase, but it could happen if the 

phrase is said in isolation—for instance, if the speaker is creating a list or had just hesitated as one often does 
when composing out loud. (If this does happen, one can say undo that.)

Remember in particular the possibility of unintended recognition of cut <xyz> and delete <xyz>, especially if 
you dictate without looking at the screen. If you prefer to avoid this risk, disable these commands by clearing 
their checkbox on the Commands tab of Dragon’s Options dialog.
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Full Text Control, “non-standard” fields, and the Dictation Box

Commands such as ‘correct <xyz>’ and ‘insert after <xyz>’, which quote words from the active text field, 
work thanks to a Dragon functionality called Full Text Control (formerly “Select-and-Say”). This functionality 
requires the text field to let Dragon be aware of its content—such as where words and sentences begin and 
end.

Many popular applications build their text fields (or at least most of their fields) in a standard way, and as a 

result Dragon always has Full Text Control in these fields. However, you may sometimes encounter a text field 
for which Dragon cannot have awareness—and therefore Dragon cannot always apply all its normal capabilities. 
(For instance, it may not capitalize the first word you dictate in that field.) You may not notice anything 
unusual if you just dictate a flow of words (especially if you start with a word that is always capitalized, such 
as a name or the subject pronoun “I”). However, if you take actions on the text (such as correcting a 
misrecognition or inserting text within a sentence), Dragon may not be able to execute its “<verb> <xyz>” 

commands or apply spacing as it usually does. 

When the insertion point is in such a text field, the DragonBar displays a special message and its Text Control 
indicator is dimmed.

Even in “unknown” (“non-standard”) text fields, one can use Dragon efficiently, knowing the following:

If dictating short entries, you may want to just apply what does work in all text fields: dictate normally 1.
and, if necessary, say ‘spacebar’ (or press the spacebar), say ‘cap’ before a word to force its capitalization 
(you can also address capitalization after completing your dictation, using the commands “cap that” or 
“capitalize <xyz>”), say ‘move <left|right|up|down>’ commands or reposition the insertion point by 
hand, etc.
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If you want to dictate something substantial, consider using Dragon’s Dictation Box, an intermediary 2.
window containing a text field in which you can create, modify, and correct text as usual, with Full Text 
Control. (If your edition supports them, you can even use boilerplate custom commands to paste text.)

When the text is ready, just say or click the 
Transfer button: Dragon closes the 
Dictation Box and transfers your text to 
where you had the cursor.

To open the Dictation Box, you can:

Say a command such as ‘Open ••••
Dictation Box’ 

Use the DragonBar’s Tools menu•

Use its hot key: Ctrl+Shift+d•

There is a lot of flexibility around the Dictation Box. In addition to changing its hot key in the Options 
dialog, you can:

Give its command one or more alternate names (from the Command Browser: to find the command, •
you can filter for the word ‘box’, with ‘Global Commands’ selected in the Context list).

Modify its appearance and behavior, via its Settings button: default font size, positioning (anchored, or •
near the cursor), whether it shows how many characters it contains…

TIP: You can have 
different settings for 
different applications. Also, 

you can have multiple 
Dictation Boxes open at one 
time.

The Help contains more 
details.
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Replacing and Inserting Words

The select commands are very useful when you wish to change some of the text on your screen. As you would 
with mouse or keyboard, you select the relevant segment, then you overwrite it—by dictating or typing. 

For instance, if your text reads "100 Main Street" but you wish to change it to "500 Washington Street", say 

select 100 Main (pause) 500 Washington. 

TIP For larger passages, take advantage of select line, select <start> through <end>, select paragraph… The 
command “resume with…” can also be very efficient as an equivalent of selecting then deleting what you have 
just dictated up to a particular word; be sure to read about it in the Help and try it out.

Exercise 1:  Practice “overwriting” by voice. Observe then dictate the following paragraph.

I will be in Boston for a few days next week, and would love to get together for lunch. We could meet 
at your office at noon. I’ll be staying at the Madison downtown; give me a call. Talk to you soon!

Say select lunch. �  You should see the word “lunch” highlighted.1)

Say an early dinner. ����  The sentence should now read “get together for an early dinner.”

Say select noon. �  You should now see the word “noon” highlighted.2)

Say six o’clock. �  The sentence should now read “We could meet at your office at 6:00.”
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Say select in through week. �  The words “in Boston for a few days next week” are highlighted.3)

Say in your area on Tuesday. �  The sentence should now read “I will be in your area on Tuesday…”

Let’s say we now want to add a few words inside this paragraph. 

Observe the insertion point’s current position. Say insert after dinner, then say if you have time.4)

Say insert before exclamation mark (observe the move), then say comma I hope.  5)

TIP  If, after doing some editing in your text, you need to remove trailing white space, you can use commands 
such as backspace or delete next character for a single space.  A good trick is saying backspace combined 
with a number: backspace 5 is like pressing the backspace key 5 times.

Dragon’s many selection and navigation commands can help you quickly edit text—whether or not this text was 

created by voice. Below is another exercise, to be performed entirely by voice, but remember that for optimal 
productivity in daily work, you can use a combination of voice and keyboard/mouse.

Exercise 2:  Look at the following text, dictate it, then edit it by voice as described below. 

Dear Ms. Cooper,

It was nice meeting you Tuesday. I think you have some good ideas about the Johnson project!  Let’s get the 

team focused on this project by February. When you have time, could you write up your comments and email 
them to me?  I would really appreciate it.

Edit the first sentence so it reads "meeting with you last Tuesday".•

Edit the second sentence so it reads "You have some great ideas".•

Edit the third sentence so it reads "on this important project".•

Edit the third sentence so it reads "by early February", and insert a blank line after it.•

Change the fourth sentence to “Could you please write up your notes and email them to me ASAP?”•

Edit the salutation, changing "Ms. Cooper" to "Allison".•

Edit the last sentence, removing "really", and add a closing line of "Sincerely, Susan Martinez".•

Which commands did you find most useful in each situation?

Key points about editing text by voice

You can use Dragon to edit a document by voice whether the document was dictated or typed.�

The editing commands can address small or large amounts of text, even several paragraphs or the �

entire document (select all).
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At first, uttering the whole command can be tricky for commands that quote words from your text, �

such as select… through… and insert before…. As usual, deciding what you are going to say before 
starting to speak is recommended. If you paused mid-command, just say scratch that, pause, and give 
the complete command again.

The commands that quote your text (select <xyz>, bold <xyz>, correct <xyz>, insert after <xyz>…) ����

work thanks to a functionality called Full Text Control (formerly Select-and-Say), which depends on 
Dragon’s ability to constantly obtain information from the text field—for instance, in order to know 
where words and sentences begin and end, so Dragon can apply spacing between words and 
capitalization at the beginning of a sentence... 

If the text area in which you are dictating is “unknown”, remember that if needed you can say Cap to �

start a sentence and spacebar to create a space, as well as use the Dictation Box—a text window that 
has Full Text Control: when you are finished, the content is transferred to your original location. (See 
the Help for more details.) 

You can modify the Dictation Box’s appearance and behavior from its Settings button; in addition, you �

can modify its hot key in the Options dialog and give its command one or more alternate names.

You can set the Dictation Box to behave differently depending on the application from which you �

opened it.



Copyright  2011  Nuance Communications, Inc. All rights reserved 64

Formatting Text by Voice
Whether text was originally dictated or typed, Dragon NaturallySpeaking lets you use your voice to control font 
(Arial, Courier…), font style (bold, underline…), font size, alignment (center, right-align…), color, and more.

The "X that" Convention

Dragon has many commands to tell the computer to perform a certain action on a certain item. Many are 
phrased as "X that", with X being a verb for the desired action: for instance, italicize that and delete that.

Remember, for commands to be recognized, you must pause before and after but not in the middle. 

When Dragon hears an "X that" command, it decides what “that” is as follows:

If anything on the screen is highlighted (whether by voice or by hand), Dragon performs the action on 1)

that selection. (It can be one or more characters or words.)

If nothing is highlighted, Dragon performs the action on whatever you dictated since you last paused—in 2)
n other words, the contents of the Results box, the last utterance.

Note: In Dragon’s commands, you can say “the selection” instead of “that”.

Dragon's "X that" editing commands include:

Cap that – capitalizes the first letter of each word in the segment (e.g. Water Management)

ALL CAPS that – capitalizes all the letters of each word in the segment (e.g. EXTREMELY IMPORTANT)

no caps that – puts in lowercase all the letters of each word in the segment (e.g. american express)

delete that (Version 11 also lets you use “delete <xyz>” as seen in the lesson on direct editing)

scratch that  

TIP     To delete your last utterances, you can repeat scratch that or specify a number of times (scratch that 
3 times, scratch that 8 times, etc.) but the command “resume with…” can be most efficient.

bold that, italicize that, underline that (Version 11 also lets you say “<verb> <xyz>”)

restore that – removes all bold/italics/underline formatting from the segment

left-align that, right-align that, center that, justify that  

copy that and cut that (you can also use “<verb> <xyz>”)

paste that

hyphenate that – puts hyphens in the spaces within the segment

compound that – removes spaces between words in the segment

bullet /unbullet that (make sure you are familiar with how your particular application handles bullets)
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TIP  The Command Browser’s Keyword Filter lets you explore additional command wordings for the 
application(s) you frequently use. For instance, in Word and WordPerfect, you can say “turn bullets on” and 
“turn bullets off.”

The "Format That" Commands

Not all formatting commands are worded as "X that", but all follow the same rules about what text the action is 
performed on: the selection if there is one, otherwise the last utterance (what was said since the last pause.)

As seen in the Command Browser, the many formatting commands include:

format that bullet style –- bullets the designated text (you can also say set that to or make that bullet style)

format that centered

format that regular

format that strikeout –- places a line through the selection (for example, January 19)

Note that formatting commands can combine several indications, such as:

format that Garamond, format that Arial 12, etc. –- gives the selection the font name/size specified
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format that 20 point, format that 12 point, etc. –- gives the selection to the point size specified

format that bold italics 

format that caps bold

format that bulleted and plain

Exercise:  Dictate the following to experiment with giving format commands as you dictate and afterwards. 

I finally read The Grapes of Wrath. It was TERRIFIC! Although it is long, I read it surprisingly quickly.

TIP  To undo the last action, say undo that. This is equivalent to Undo in the Edit menu, or the keyboard 
shortcut Ctrl z.

Key points about formatting documents

The “X that” commands apply to the current selection, or if there is no selection, to the last utterance �

(what was dictated since the speaker last paused.) 

As with all Dragon commands, you must pause briefly before and after saying these formatting �

commands.

You can repeat delete that or scratch that up to 10 times to delete the last things you said—you can �

also say scratch that 3 times, scratch that 7 times… For deleting the end of your dictation up to a 
particular word, the command “resume with…” can be very efficient.

To undo the last action, you can say undo that (which is equivalent to “press control z”). �
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Controlling the Operating System and Applications 
Dragon NaturallySpeaking can do much more than type and format your dictated text: it lets you start 
programs, open desktop items, switch between open windows, maximize or minimize windows, choose menu 
and submenu items, navigate dialog boxes, “voice-click” buttons, “voice-press” keys, move the mouse pointer, 
and much more, without touching the mouse or keyboard. 

Of course, when Dragon is running, you can still use your mouse and keyboard. Mouse, keyboard, and voice are 
just three input options. Use whatever is fastest and easiest for a given task.

Let’s start with a very frequent task made fast and easy thanks to Dragon: searching your computer.

Keyword-Searching the Computer 

Available in the higher editions, the “Dragon Voice Shortcuts for Desktop Search” help speed up a process many 

of us go through very often: finding information that we know is somewhere on our computer! 

At anytime, no matter what application is currently active on your screen, these commands let you launch the 
search for items containing the keyword(s) you specify. They use indexing software including Google Desktop 
(freely downloadable from Google’s website).  

They have flexible wordings (the Command Browser lets you see all the possible ways to say them) and can be 
general (“search computer for <xyz>”-- <xyz> being any word or words), or specific:

Search emails for <xyz>: searches for the keyword(s) <xyz> in just the e-mails indexed on your •
computer

Search [the] documents for <xyz>: searches just the indexed files•

Search [the] history for <xyz>: searches just the indexed Web pages visited•

Note: 

These “Desktop search” 

commands can be disabled or 
enabled on the Commands tab 
of Dragon’s Options dialog.
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Opening and Closing Programs and Windows

To close the active window, you can say click close.

To start a program by voice, you can say start (or open) immediately followed by the name of the application. 
For instance, start DragonPad, open Internet Explorer, start Notepad, start Paint, or start Windows 
Explorer. 

TIP  Do you need to say "start Word", "start Microsoft Word" or "start Microsoft Office Word 2007"?  In the Start 
Menu (on your Windows taskbar), look in Programs. Some programs require clicking a series of submenus. 
Whatever the final submenu is called is the name Dragon may expect (except for popular applications listed in 

the Help; for these, shorter names are supported). If you find the listed name inconvenient, you can create a 
shortcut to the application and rename that shortcut to something easy; once you have done that, you can also 
use the easier name to open the application.

Similarly, you can open any item you see on your desktop (including files and folders): just say open followed 
by its name. For instance, to open an item called “winter projects”, you could say open winter projects. (Here 
too, it’s helpful to have easily recognizable names!) 

To open the Windows Start menu, say click Start or click Start menu (this and other menus can be navigated 
by voice, as you will see).

Resizing Windows and Switching Between Them 

To minimize an active window, say click minimize or minimize window (the window remains on your screen, 
minimized as a taskbar icon). To maximize (enlarge to fit the screen) an active window, say click maximize.

If several windows are open on your computer, you can change which one is active and in the foreground in 
several ways:

Say list all windows then say (or press) the number of the desired window. Note that, particularly if •
many windows are open, you may wish to specify an application, by saying list windows for 
<application>, for instance: list windows for Internet Explorer.) 
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You can also say the following:

“switch to” followed immediately by the name of the desired application, folder, or document: e.g., •
switch to DragonPad, switch to Lotus Notes, switch to My Computer, switch to DragonBar, switch to 
winter projects.

switch to previous window to go back to the previously active window. •

switch to next window as many times as necessary to cycle through all the open windows (this is •
equivalent to pressing Alt +Tab).

“Clicking” Menus and Controls

To "click" on an application menu or submenu, just say its name; for instance, for a menu labeled Insert, say 
Insert. (The application must have the focus, which you can usually tell by the appearance of its title bar.)

When accessing a submenu, pause briefly after the name of the menu. For instance, to see the available 

toolbars in applications like Word 2003, you can say View (pause) Toolbars, and to save a file under a certain 
name, you can say File (pause) Save As.

TIP  To close an open menu, you can just say cancel or press Escape (just like pressing the Esc key at the top 
left of your keyboard.)

To use Office 2007 by voice, first familiarize yourself with the “Ribbon” and its ScreenTips (revealing the 

item’s name), Quick Access Toolbar, and KeyTips (the new display of keyboard shortcuts).  Note that the 

command to click the Office Button  (equivalent to the File menu of earlier Office versions) is "Office 
button".

With Office 2010, Microsoft introduced some changes to the applications’ interface – in particular, it introduced 
the File Tab. The other tabs can be accessed by voice by just saying their name, but for the File Tab you must 
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say “file tab” (or “click file tab”.)  For details on Dragon 11’s support for Office 2010, please see the Help 
(remember that you can search it directly by naming search keywords in a command such as “search Dragon 
help for open quote office 2010 close quote”) and the resources on www.nuance.com.

.

TIP  By default, some Microsoft applications show only the most-used menu items. For optimal voice usage, 
consider changing this default (this may be located in the application’s Tools menu: open the Customize dialog 
and check the box “Always show full menus.”)

Menu items often open dialog boxes, which may contain controls such as buttons, checkboxes, tabs, and radio 
buttons. How do you access these by voice? You guessed it: “say what you see”!

IMPORTANT:  You can choose to have Dragon require the word ‘click’ just before the name of menus and 
dialog box controls: for instance, for a button labeled “OK”, you would say click OK. This can be useful to 
prevent unintended recognitions, such as the inadvertent voice-clicking of the “Send” button in email. Dragon 
offers a similar “Require ‘Click’” option for HTML links (it applies to hyperlinks in supported Web browsers as 
well as in the Dragon Tutorial, Sidebar, and Accuracy Center). See the Commands tab of Dragon’s Options 

dialog.

This workbook presents several of Dragon’s dialog boxes, which often contain controls labeled Cancel, Yes, No, 
or OK; as you follow the step-by-step instructions and perform the exercises in each chapter, take the 
opportunity to practice accessing the boxes and their controls by voice. 

Exercise 1: Previous lessons introduced you to the Options dialog box; we will use this dialog box to practice 
accessing buttons, tabs, and other interface controls.

Open Dragon’s Options dialog, then its View tab. 1.

Select and unselect the radio buttons and checkboxes for the DragonBar.2.

Restore the defaults.3.

“Natural Language Commands” and the Command Browser
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Dragon comes with large sets of commands that let you order actions directly, and in a natural manner, instead 
of going through menus, submenus, and dialog boxes: for instance, saying “Insert Page Break” in Microsoft 
Word instead of opening the “Insert” menu, then choosing the submenu “Break”, then the option “Page 
Break”.

Dragon’s Sidebar contains a sampling of these commands (depending on what application is currently active, 
and what edition of Dragon you have.)  As you will notice, Dragon’s command names tend to describe the 
action, starting with the verb, then the object; since Dragon has so many commands, with many possible 

wordings, that you can try saying what you want to do -- and if you get unexpected results, say "Undo That".  

To read about the commands for a specific application, open the Help (you can say give me help or ••••
show Help topics), or launch a Help search directly with a command such as “search Dragon Help for 
Internet Explorer commands.” You can also jump to relevant Help topics directly from the Sidebar’s 
hyperlinks. 

To see all the commands and their variations (optional words, alternate words, etc.), open the •
Command Browser and use its Context list and Filter box to display just the commands that contain a 
particular word or words and are active in a particular application. When you see in the list a command 
that looks interesting, make sure it’s highlighted in the list then use the links on the Command 

Browser’s menu to expose its full wordings (for instance, to include all optional words or to expand 
ellipses.)

IMPORTANT:  If it detected that your computer’s resources would not allow it to perform with both speed 
and accuracy, Dragon may have disabled its Natural Language Command sets for Word, Excel, PowerPoint, and 
WordPerfect.  If speed is not a priority for you, and you wish to use Natural Language Commands in one or all 
of these applications, enable them via the Option dialog’s Commands tab. (See the Natural Language 
Commands button near the bottom.)

If you enable the Natural Language Commands for Microsoft Word, for instance, Dragon’s speed may decrease 
within Microsoft Word (or Microsoft Outlook using Word as its editor).

“Voice-Pressing” Keys

At times, you may wish to press a key or two on your keyboard; you can use Dragon to “voice-press” them.

TIP  Common accelerator keys for Windows operating systems include: Esc to close a window, Enter to active 
the item which has the focus, Tab to move the focus forward, and Shift+Tab to move the focus backward. Most 
buttons, menus and checkboxes have an underlined letter in their label: you can activate them by pressing the 
underlined letter (if underlines are not visible, press Alt first.) For accelerator keys specific to a particular 
application, search the application’s Help or the Internet.

Dragon lets you “voice-type” any key on your keyboard. Just say press or type followed by the name of the 
key(s): any letter or number, but also Page Up, Home, Enter, Tab, Caps Lock, F2, Control, Alt, Shift... 

For instance:

Say press spacebar to select or unselect a checkbox.

Say press F5 or press Function 5 to refresh the view.

Say press Alt e to “click” a button labeled with an underlined ‘e’.

Say press Control f to open the Find dialog box in most applications.

Say press Escape to “escape” out of a window.
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Say press Alt Down to open a drop-down list.

To undo a keystroke, you can say undo that.

Exercise 2: Observe the Find and Replace dialog box below and its controls: tabs, drop-down lists, checkboxes, 
and buttons. Answer the following questions (think of “voice-typing” as well as “voice-clicking” 
options), then open a similar dialog in your word processor and practice navigating it by voice. 

How could you place the insertion point in the Find field? How could you go to the other tabs?•

Which control currently has the focus? How could you move the focus to the Find Next button?•

How could you close this dialog box?•

Key points about controlling your computer by voice

You can open an application (or desktop item) by saying start or open immediately followed by the �

name of the application (or item). You may want to provide easy names for these items.

You can switch between windows with commands like switch to DragonPad, switch to next window.�
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To click menus, buttons, and other controls, you can “say what you see” (you can choose to say “click” �

right before, or not.) 

You can “voice-press” any key by saying press or type followed by the name of the key.�

Dragon 10 offers commands to search your computer for items containing the keyword(s) you specify �

(these commands take advantage of the indexing done by software like Google Desktop, which must be 

running on your computer). For instance, to find all indexed e-mails containing the words “Canada” and 
“budget”, you can say search email for Canada budget.
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Using Dragon NaturallySpeaking with the Internet 
Below are some commands for common Internet-related tasks. The Command Browser lists many more, and the 
Help contains a lot of detail about using your voice on the Web and about Web-related Dragon options.

TIP Dragon includes commands you can say anytime to perform general Web searches, Web searches in 
specific categories (maps, news, products, images, videos) or searches in certain specific sites, like Wikipedia. 
You could say for instance ‘search images for chrysanthemum’ to see images found for that word by your 
default search engine. 

You can even take advantage of capabilities of specific engines: one example is Google’s conversions and 
calculations, as in ‘search Google for 53 percent of 1100’ and ‘search Google for 77 euros in dollars’. 

A key advantage of these “Web search shortcuts” is that, like the “desktop search shortcuts”, they can be used 

anytime, no matter what program is currently active on your screen; they are very convenient time-savers!

NEW: In Dragon 10, search shortcut commands executed the search automatically. In Dragon 11, you can edit 
the search string first: the new Edit Search Keywords dialog lets you revise, replace, or augment your dictated 
keywords. The option is now on by default for Web and Desktop search commands. If you turn this option off, 
you may not see any action on your screen right away after giving one of these search commands; this is normal 

since the search itself needs a moment to complete. 

The following covers actions often done in HTML pages and work with supported Web browsers (Mozilla Firefox 
and Microsoft Internet Explorer). There are many more commands; please see the Help. 

Navigation

Say go to address to go to the address bar; after entering a URL, say go there or press Enter.

Say go back or go forward to click the Back or Forward buttons; say go home to access the homepage. 

Say add to favorites to add the current site to the Favorites list.

Say refresh page or reload page. (To stop a page load, you can say stop loading.) 

Say page down or start scrolling down to see more of the web page. (You can then say stop scrolling.)

Accessing a specific item on a Web page

Note: For all these commands, if what you said matches multiple items on the screen, Dragon will display 
numbered arrows next to the items; to indicate the desired item, say choose 3 or whatever number 
corresponds to your choice. (If you need the numbers to go away, just say hide numbers.)

To click a hyperlink, you can say its name or just part of it, preceded by the word ‘click’ or not. (If a 
red arrow appears next to it, say click that.)  

IMPORTANT:  Dragon is always looking to match what it hears to possible commands. For HTML 
windows, you can choose to require ‘click’ before the link name, since if you dictate a word or phrase 

in isolation, it may activate a link instead of being transcribed—see the Commands tab of the Options 
dialog; this option is on by default in Version 11. 
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Say text field or edit box to move the insertion point to the first text field on the screen. If you want 
to dictate into the next text field, you can say next control.

Say click image to click on an image (on the Web, some items may be designed to look like text 
buttons, but are actually images.)

Say click check box to select (or unselect) a check box.

Say click radio button to select a radio button (round option button).

Say click list box to select a list box, and drop list to display the list (to highlight list items, you can 
use the move up n and move down n commands)

Say click close or press Escape to close a popup window.

Note: These commands require the setting "Enable commands in HTML windows," which is on by default and 
can be found on the Command tab of the Options dialog.
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Using Dragon NaturallySpeaking for E-mail 
Dictating is in itself a great benefit for e-mail usage. For certain e-mail applications, you can go far beyond 
dictation. This lesson introduces important commands and tips for using Dragon with e-mail. 

IMPORTANT  Users of Lotus Notes, Outlook, Outlook Express and Windows Mail can take advantage of 
Dragon’s ‘Increase Accuracy From E-mail’ tool to automatically adapt the Vocabulary based on sent emails 
and to identify names of Contacts. Note that, although Dragon can automatically format email addresses and 
URLs as you dictate them, it can be efficient to add to the Vocabulary the e-mail addresses and domains you 
use frequently (do specify Spoken Forms as needed.)

Voice Shortcuts

For Microsoft Outlook, there are many commands for the Inbox (you can forward, move, or flag messages, for 
instance), Tasks, Calendar…  For quickly creating messages, appointments, and tasks, Dragon 11 even offers 
“shortcut” commands that include dictation and work no matter what is currently active on your screen. At 
any time, whether or not Outlook is open, you can say for instance “create email to Jane Miller and Payroll,” 
“schedule meeting with Joe Keller and Jane Brown,” “create appointment at noon,” “create task about office 

supply inventory,” or “email that to Jane Miller” (the “that” being the selected text or file). 

Before using these commands, make 
sure Dragon is able to recognize 
custom words such as the names you 
plan to mention (use the Accuracy 

Center). 

Note: These shortcut commands 
require the option "Enable E-mail and 
Calendar commands" which is on the 
Commands tab of the Options dialog.

Remember to explore the Command Browser’s “Context” list, and take advantage of the Sidebar and the Help: 
for instance, you could say “search Dragon help for Outlook calendar.”
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Commands for within the email program

Note: In e-mail commands, you can substitute message, e-mail, or memo for mail.

You can start your default e-mail program by saying Start mail. With the e-mail program open, you can say:

new mail – creates a new mail message

open mail – opens the mail message highlighted in the list

close mail – closes the open mail message

forward mail / this– forwards the highlighted or open mail message

reply to mail / this – replies to the highlighted or open mail message

delete mail – deletes the highlighted or open mail message
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check for new mail – checks for new mail/opens your Inbox

TIP  In lists (of messages, of folders…), you can use navigation commands like move down 3, move up 9…

As you create e-mails, you can move between fields by hand, by saying Tab or Tab key, or by saying the 
following (the word field is optional, and you can substitute go for move):

move to To [field] – moves the cursor so that you can then dictate the recipient's address

move to CC | BCC |Subject [field]

move to Body [field] – moves the cursor to the body of the e-mail so that you can dictate the message

Note: If you wish to use Web-based email such as Gmail, be sure to familiarize yourself with Dragon 11’s 

support for Web browsers (Internet Explorer and Mozilla Firefox). Within Gmail, you may also wish to explore 
the impact of switching from Gmail’s Standard display to its Basic HTML display.

Key points about Dragon 11 and e-mail 

In supported e-mail programs, the higher editions of Dragon provide many voice commands to perform �

tasks, such as open message, delete memo, go to Subject…

In e-mail commands, you can use the words message, e-mail, memo, or mail interchangeably.�

If you have Microsoft Outlook and your edition of Dragon supports them, you can use direct commands �

(the “Dragon Voice Shortcuts”) like book meeting with <contact(s)>, create message to <contact(s)>, 
create email about <subject>, and create task about <subject>, no matter what application is 

active: there is no need to first switch to Outlook. 

You can see more e-mail commands in the Command Browser and the Dragon Sidebar; in addition, the �

Help contains many details about using Dragon with e-mail. Remember that Dragon 11 contains a 

command that lets you name keywords to search for in the Help: for instance, you could say “search 
Dragon help for Outlook calendar.”
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Dragon NaturallySpeaking and Microsoft Word 
In “Controlling the Operating System and Applications”, you learned about Natural Language Commands. Since 
Microsoft Word is an application many people use, this chapter lists built-in commands for this word processor.  
Corel WordPerfect has similar commands, so it shares the same Dragon Sidebar content. 

Remember that if your system resources are low, enabling Natural Language Commands could decrease 

Dragon’s speed. (Note also that if an application’s set is disabled, the Dragon Sidebar will not show special 
content for that application; instead, it will show Global commands).

In addition to commands, this chapter covers special points of interest regarding Microsoft Word: ctfmon.exe 
and the Voice Notation feature.

Special note for Windows XP: turning off CTFMON

After installing Dragon on a Windows XP operating system, errors may start appearing when using Microsoft 
Word if the Microsoft Alternate User Input application (CTFMON.EXE) is also running. You can disable 
CTFMON.exe thanks to a simple checkbox on the Miscellaneous tab of the Administrative Settings dialog box. 
(Administrative Settings is in the DragonBar’s Tools menu.)

“Voice Notations” in Microsoft Word documents

The higher editions of Dragon let you add “Voice Notations” in Word: text that can later be used with Word's 
Accept/Reject Change functionality. A Notation could be anything you do not want permanently in your 
document or you do not want transcribed, e.g. instructions you speak for the benefit of your assistant. Voice 
Notations are not used by the Acoustic and Language Model Optimizer. 

To add a Voice Notation, press the Esc key while dictating. Voice Notations are highlighted in green and 

formatted as red italic text.

Commands specific to Microsoft Word

For applications like Word, Dragon has so many commands (and many different wordings for most commands), 
that we couldn’t possibly list them all here or in the Sidebar. 

If you are working in a supported application and you encounter an action you’d like to perform by voice, use 
the Command Browser’s Context list to pick that application and use its Filter to see just the commands that 

contain a particular word or words. If you see a command that looks interesting, make sure it’s highlighted in 
the list, then use the Browse menu to uncover its full wordings (for instance, to include all optional words or 
expand ellipses.)

TIP: If you say what you think is a command but Dragon takes no action or just transcribes the words on the 
screen, look for the Results box. If you do not see your command (with a thick border around it), Dragon did 
not recognize what you said as a valid command for the current situation: for instance, if you say "Insert a 2 by 
2 Table" when the insertion point is inside a table, nothing happens because one cannot insert a table inside a 
table.

Pictured below is an example of a Help topic listing commands for working in Word documents. 
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Many of Dragon’s commands work for both Word 2003, 2007, and 2010, such as:

New file•

Save the file. Save file as.•

Create a 3 by 7 table •

Add page numbers [at bottom left| center | right]•

Delete next sentence•

Find a word.  Find and replace.•

Set page orientation to Landscape•

Print pages 3 to 7.  Print the selection.  Print [this] page•

View page layout.  Change view to print layout.•

Zoom to 50 percent.  Zoom to full page.  Change zoom to page width•

Set page width to 8 inches•

Show|Hide paragraph marks•

Double-space the document.  Single-space this paragraph•

Set the font color to green in this line•

Set background to yellow•

Show word count•

Microsoft Word 2007 and the Ribbon
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In addition to the Ribbon Interface (which organizes items by tabs instead of menus), Word 2007 introduced 
new capabilities for which Dragon now offers Natural Language Commands, including the ones below. 

Note: To click the Office Button (which replaces Word 2003’s File menu), you can say “Office Button.”

Office Button menu

Open/show document information [panel]•
Quick print [file/document]•
Save [document] as PDF•
Encrypt file•
Add digital signature•
Mark [the] file/document as final•
View/open/show [the] document management [task] pane•
Share [the/that/this] document/file•

Common Tasks:

Go to/Switch to/Hide/Open/Display thumbnails•
Turn side by side view off/on•
Add/create/insert [a] special character•
Add/create/insert [a] hyperlink/chart•

Page Layout menu 

Create/add/insert a watermark•
Set the page color•
For themes : •

View themes; Set colors of themeo
Change the font of [that/the/this] themeo

For line numbering : •
Create/add line numbering continuouslyo
Delete/remove line numberingo

Reference menu 

Previous footnote/endnote•
Create/add/insert [a] citation/caption•
Create/add/insert index•
Add [this/it/that] in the index•

Review menu 

Show/view/open/hide/close [the] research pane•
Translate the first sentence/word. Translate the entire page•
For comments:•

Create/insert/add [a] new commento
Erase/delete/clear all comments showno
Go to next/previous commento

Hide/close [the] review pane•
Accept/reject change and go to next•
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Blog Post menu 

Create a new blog account•
Open a blog post•
Publish [this/that] post to [the] blog account•

Mailings menu

Create blank/new envelope/label•
How/view/hide merge preview•

Dragon 11 and Microsoft Word 2010

With Office 2010, Microsoft introduced some changes to the application interface – in particular, the File tab. 
The other tabs can be accessed by voice by just saying their name, but for the File tab you must say “file tab” 
(or “click file tab”.) 

For details on support for Office 2010, please see Dragon 11’s Help and website resources. 

A Windows 7 note:

In Windows 7, WordPad has an unnamed button instead of a File menu. To click it, you can say “application 
menu”.
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Dictating and editing in Microsoft Excel
You can use Dragon to dictate and edit content into Microsoft Excel spreadsheets.  Many Excel-specific 
commands are built into the higher editions; the Dragon Sidebar window shows some, and the Command 
Browser lets you discover the full set.  In addition, the Help describes commands usable in Excel to fill or hide 
rows or columns, sort, sum or average values, widen columns, and more (see Help example below.)

Remember that the Natural Language Commands for Excel may be disabled or enabled from the Options dialog.

In this lesson, sample steps guide you to practice tasks such as entering text, moving between cells, editing 
existing cells, and correcting recognition errors inside cells.

IMPORTANT:  If you want to mention a cell in a command (such as “move to cell D5”, or “select cell B3 
through cell H3”), be sure to say the word “cell”. Note that, instead of the letters, you can say alpha bravo 
Charlie, etc.

There are two editing modes in Excel: Quick and Full. Make sure you are familiar with how your version of Excel 
functions, especially for editing content in cells; notice when the Status Bar (bottom left corner) indicates 

“Edit” and when it indicates “Enter” -- as well as when the mouse pointer changes.

Quick Edit: To enter new content into a cell, overwrite the current content of a cell, or format the •
entire content of a cell. When you select a cell and begin dictating, a yellow background appears; if 
the cell currently contains text, the dictated text will overwrite it.

Full Edit: To edit the existing contents of a cell. Select the cell and say "Edit Cell" or "Press F2" to open •
the cell for editing; the insertion point is automatically placed at the end of the cell. As you dictate, 
the background changes to blue. Commands such as "New Line" operate within the cell. 

TIP:  To quickly enter a predictable series of values, such as days or months, you can use commands such as 
“Monday through Friday across” or “July through December down.”
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Full Text Control in Quick Edits

You will want to practice entering data into a spreadsheet and navigate around the spreadsheet and within 
cells, as well as dictate and correct text using commands like “correct <xyz>” (see Full Text Control, called 
Select-and-Say in previous versions).

For the exercise below, the content of the spreadsheet is not important. 

Step 1: Open Excel, say open document and locate 
the relevant .xls file – or use a blank file. 

Step 2: Say move to cell C7 (or Charlie seven.) 

Step 3: Dictate your full name into the cell.

As you dictate, the cell background turns pale yellow, 
indicating that Dragon is doing a Quick Edit.

Let’s practice correcting recognition errors so Dragon can learn from them:

Step 1: Say move to cell C 13 (or Charlie 13). Dictate some text that is likely to contain unknown words, such 
as: “Travel to Ashtabula to provide support for Sporkatron, Inc.”

Step 2: Correct one of the recognition errors. (Leave the remaining errors as they are, so you can practice 
coming back to this cell and correcting them later.)

Step 3: Say move down one to go to cell C14. Dictate some additional text that is likely to contain new words, 
such as: “related to last week’s trip to Kenmawr—training Moosehart Insurance”

Now that you are out of the cell, practice going back to it and correcting the error(s) in it.

Step 1: Say move up one to move back to cell C13. Say a “correct <xyz>” command to correct another of the 
errors Dragon made. Notice that the cell again turns yellow.

Continue correcting the text until it is accurate.

Step 2: Say apply. You are no longer in Quick Edit mode; the cell you were editing is still selected.

Now let’s practice entering numeric data rapidly into a row.

Step 1: Say move to cell B16 or move to cell Bravo 16 to move to the Breakfast row. Dictate a numeric value 
such as six dollars and fifty cents.
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Step 2: Say move right one to move to the next Breakfast entry. Fill in the rest of the row.
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Key points about editing cells in Excel

You can navigate between cells using absolute commands such as move to cell A1 or relative �

movement commands such as move up one, move right two, etc.

If you want to mention a cell in a command (such as move to cell D5 or select cell B3 through cell ����

H3), be sure to say the word “cell”. You can speak the letters as alpha bravo Charlie, etc. instead of A 
B C. 

If you wish to modify and add to the existing content of a cell, move to that cell, then say Edit Cell or �

Press F2; the insertion point will appear at the end of the cell’s content and the cell will now have a 
blue background. If you say commands like New Line and New Paragraph, these commands are 

executed within the cell.

If you just move to a cell and start to dictate, what you dictate will overwrite the existing content.�

You can use Dragon commands like select <xyz>, correct <xyz>, and insert before <xyz> to edit and �

correct text in a cell.

To complete entry and move down one cell, say press Enter. To cancel entry and remain in the cell, �

say cancel or press Escape.

Saying apply completes entry into a cell, and leaves the focus on that cell (exiting Quick Edit mode).�
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Boosting Productivity with Custom Commands
In previous lessons, you learned various built-in voice commands to perform actions such as formatting text, 
searching the Internet, creating a new e-mail, creating a new appointment… The higher editions of Dragon also 
allow the creation of custom commands.

There are several types of custom commands; this workbook presents the “Text-and-Graphics” type, which 

allows you to define boilerplate for Dragon to paste wherever you utter the command. As the name indicates, 
this boilerplate can contain graphics, such as logos, scanned signatures, maps… Quick and easy to create, Text-
and-Graphics commands provide considerable time savings and convenience. In editions Professional and Legal, 
you can even include fields in them—a very easy way to create templates that can be both created AND 
navigated by voice.

Creating Boilerplate Commands (“Text-and-Graphics” Type)

Step 1:  Open the MyCommands Editor—you can say add new command or choose Add New Command in 
the Tools menu. 

Step 2:  Think of a name for your command and enter it in the MyCommand Name field.

IMPORTANT: The command's name is the phrase you will say to cause the command to execute. Choose it 
well!  It should be easy to remember and easy to say, like Paste Signature Block and Enter Home Directions. 

Choose a descriptive, meaningful name (as opposed to a name like “macro 3”.)•

Make it neither long nor short (between 2 and 5 words is usually best).  Avoid single words, and •
phrases you may need to dictate.

Use words that are easily pronounced and recognized (all words in the command name should be in •
the Vocabulary), and avoid symbols—for instance, use “number” instead of “#”, otherwise Dragon  
would expect to hear “number sign” or “pound sign” when you say the command.

Step 3: In the Description field, enter some information about your command. This is optional, but it helps 
remember any important details about the command (its intent, when and where you might use it…).

The following step applies only to the higher editions of Dragon.

Step 4: Optionally, choose a group. In the Group field, you can highlight and overwrite the default. 

Creating custom commands groups can later 
allow you to locate and manage many commands 

quickly. Aim to name your groups meaningfully: 
for instance, the name of the application or task 
for which you are creating the command(s).

Once a command Group is defined, you can add 
more commands to that group (Dragon will now 
include it in the “Group” drop-down list).
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IMPORTANT: If desired, you can always assign the command to another group later.  Since the Sidebar’s 
MyCommands tab only shows custom commands that are in the User-Defined group, you can choose which 
commands to display there by making a “clone” of the desired command and assigning it to the User-Defined 
group. (See this lesson’s section on cloning.)

Step 5: In the Content field, enter what you want Dragon to paste when you say your command. (You may find 
it helpful to enlarge or even maximize the Editor’s window so that a larger Content field is visible.)

TIP  If the text you want already exists in electronic form, you can save time: highlight the desired 
segment in the original document, then say “make that a command”. Dragon will automatically open 
the Editor and paste the selection in the Content field. All you have to do now is specify the 
command’s name and attributes, and edit the Content as needed. 

As its name suggests, this type of custom command lets you include graphics as well as text: you can 
paste images from another application into the Content field—many people include maps, logos, or 
scanned signatures, for instance.
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Optional: If desired, format the text entered in the Content field: you can use the buttons (bold, left-
align, center…) below it. Clicking the Aa button opens the Font window, where you can choose the 
desired font style, size, color, etc. 

IMPORTANT: In cases where you want the content to match the formatting of what preceded it in 

your document, check the Plain Text checkbox (see the bottom right of the MyCommands Editor).

Step 6:  Once the command is named, edited, described, grouped, and formatted as you want it, click Save.

Let’s test your command. Say start DragonPad, then say your command’s name. (Commands you create 
yourself follow the usual rule: you must pause before and after, but not in the middle!) 

You may realize now that you could make your command even more convenient: for instance, by adding a 
blank line before the content so your pasted content automatically starts as a new paragraph. A section below 
explains how to edit a custom command.

“Cloning” Commands and Adding Name Editor Variables

Instead of making a command from scratch, you can create a new command based on the “clone” of an existing 
one, by clicking New Copy on the Command Browser (or the Create New button on the Command Editor.)

In addition, the MyCommands Editor’s Name Editor allows the inclusion of <variables> in your command 
names. Variable names provide flexibility (so you can use synonyms instead of just one wording) and can make 
your custom commands even more useful, by letting them perform variations on the same action. 

The variables can be synonyms, or they 
can be different values, such as numbers 
from 1 to 10. 

<1to10> is one of the pre-filled lists 
available through the Name Editor, but 
you can also make your own (as was done 

for <hq_nuance> in this lesson’s 
illustrations).  

See the Help for details.
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“DragonTemplates”: Boilerplate Commands with [Fields]

(Higher editions only) Dragon 10 added to the Text-and-Graphics command type a new capability which gives a 
very simple way to paste a “voice template” containing fillable fields.

To create a field in a command’s Content box, click the Variable button at the bottom of the MyCommands 
Editor.  By default, each field appears between square brackets as "[default value]". (If you prefer delimiters 
other than square brackets, you can indicate that in the Commands tab of the Options dialog.)

After saying the command name, which pastes the “DragonTemplate”, you can:

type or dictate a specific value in each placeholder —> The placeholder is overwritten, and delimiters •
are removed.

accept the default value —> Delimiters are NOT automatically removed; you can say "clear variable •
delimiters".

To navigate a DragonTemplate’s Fields, you can select the desired Field with the mouse, or use the voice 
commands "Next Field" or "Previous Field." (These commands only work where all of Dragon's functionality is 
supported—where the DragonBar’s Full Text Control indicator is green).

Managing Custom Commands

After you create commands, you may wish to edit them. If your phone number changes, for instance, you may 
want to edit commands containing it. You may also want to rename, delete, or copy commands. 

A tool called the Command Browser lets you search for commands as well as manage your custom commands. 
In the Professional and Legal editions, deleting, renaming, modifying, exporting and importing custom 
commands can be done through its Manage “mode”, as follows. (In the Premium edition, see the Script 
“mode”.)

Step 1: Say open Command Browser. (You can also use the link in the Tools menu.)

Step 2: On the Mode section of its Task 
Pane, click Manage (or choose 
it from the Mode menu.)

Step 3: Open the Group drop-down 
list. If you created a separate 
group as suggested earlier, its 
name will appear here; choose 

it. Otherwise, the commands 
you made will be under User-
defined.

Step 4: The Command Browser now 
displays only the commands in 
the specified group, listing 

them by availability. You can 
use the + symbol to expand the 
display.

Step 5: Check the box next to the 
desired command, then click 
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To Script (which at that point 
will be available in the Task 
pane.)

This takes you to the Command Browser’s Script display, which shows all the modifiable commands.

Step 6: With your command 
highlighted, click Edit in 
the Task pane (or use the 
Script menu). The 
MyCommands Editor will 
open, displaying the 

command’s attributes and 
content; you can now edit 
the command as desired.

Remember: the Description field is 
useful for entering comments such 
as where and when the command 

should be used, or reminders like 
“make variations of this ASAP” or 
“change this after we move”. Your 
notes may seem obvious at the 
time, but they really help later!

IMPORTANT  You can delete 
commands visible through the Script 
or Manage displays: check the box 
next to the desired command(s) 
then choose Delete (from the 
menu).

Finding commands via the Command Browser’s Keyword Filter

One of the ways you can find commands in the Command Browser is by using the ability to filter the display to 
show only the commands whose name contains a particular word or words: choose Filter from the Command 
Browser’s toolbar (visible in the upper-right corner when in Browse Mode) to specify one or more words.  The 
Filter button is useful for finding custom commands (particularly if they were not filed under a Group name), 
and also for finding built-in commands, since Dragon contains far too many to list even in the online Help.  

TIP  It’s a good idea to explore the Command Browser for commands related to items you might like to 
address by voice: you might filter for words like border, indent, double space, table, row, column…

The Command Browser’s display may seem strange at first, because instead of full words some lines may 
contain ellipses (dot dot dot), parentheses, and <angle brackets>, in order to fit in the space and represent the 

many optional and alternate elements, like “the” and “a”. You can view the full wordings by using the Browse 
menu’s items—Refine and Undo All are particularly useful.
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To practice, pick your usual word processor in the Context drop-down list, and use the Filter to find commands 
on items you often use in this application.  

 

Key points about custom commands

You can quickly create custom commands to insert blocks of text and/or graphics in your documents. �

This is done in the tool MyCommands Editor, which you can bring up by saying add new command. 

If the boilerplate text already exists in an electronic document, you can copy and paste it into the �

MyCommands Editor’s Content box, or say make that a shortcut.

Providing a Group name for your custom commands makes it quick and easy to locate and manage �

them later. It’s also a very good idea to use the Description field to note a comment, a reminder…

Names for custom commands should be memorable, intuitive, easy-to-pronounce phrases. Avoid names �

that could be used as dictation, such as single words. 

The Name Editor lets you add <variables> in command names, to provide synonyms or variations (using �

lists you define yourself, or existing lists such as 1to10.)

In the Professional and Legal editions, you can add fillable [Fields] to your boilerplate commands to �

create “DragonTemplates” which can be navigated and filled out by voice.

The Command Browser allows you to rename, modify, “clone”, delete, export and import custom �

commands. 
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Performing Audio Checks and Acoustic Training
As described earlier, personalizing Dragon’s vocabulary is a small investment of time that makes a big 
difference in how accurately the software can work for you. In addition, when misrecognitions do happen, 
using proper correction technique allows Dragon to learn from its mistakes. 

In certain cases, you may also want to perform additional acoustic training to improve accuracy. This lesson 

presents how to train individual words or phrases and how to bring up a training text to read aloud, as well as 
how to use the Microphone Check, a short but important process.

IMPORTANT: When providing Dragon with acoustic training, be sure to use your natural dictation voice: 
relax, and speak clearly but not louder or slower than you would when dictating normally. Otherwise, you give 
the software acoustic data that is not representative of how you usually dictate. Remember, when you are 

training software to accurately recognize your speech, you must represent your speech accurately!

Microphone Check

Use Dragon’s audio check if something in your environment has changed: new computer, new microphone, new 

room, different ambient noise… Also, if your overall accuracy is lower than expected, you want to verify that 
your audio hardware is functioning correctly. 

Step 1: From the DragonBar’s Audio menu, click or say Check Microphone, which opens the microphone check 
wizard (formerly called the Audio Setup Wizard). You can also bring it up directly by saying check 
microphone or check audio.

*Note: Opening this Wizard automatically turns off the microphone. 

Step 2: Follow the Wizard’s screens as when you first created your Dragon profile: click the Start button and 
read the content of the gray box. Dragon will indicate whether the check passed.

If it failed, verify that your microphone is plugged in correctly and that its listening side is facing your •
mouth. (On many microphone models, the listening side is marked by a dot or the word TALK, which 
you may have to pull out the foam cover a bit to see.) If your microphone is properly connected and 
positioned, there may be a problem with background noise (including “subtle” noises such as your 

building’s temperature-control system) or with your audio hardware). Click the Help button and see the 
Knowledgebase of technotes at support.nuance.com if needed.

If it passed, click Finish. (If, once you resume dictating, accuracy is still lower than expected, see •
Improve my accuracy from the DragonBar’s Help menu.)

Training Individual Words

You have learned to add new words and phrases to the vocabulary, as well as to create Spoken Forms for items 
pronounced differently from the way they are written. Spoken Forms are often the most efficient way to 
ensure accurate recognition.

If you suspect that Dragon needs help recognizing a tricky word (particularly if it contains one or more sounds 

you cannot represent in a Spoken Form, such as a rolled r), you can acoustically “train” that word.
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Step 1: In the Vocabulary Editor, locate the word you wish to train by entering it in the Written Form field. (If 
you have just added the word, this will not be necessary, as the word will already be displayed at the 
top of the list.)

Step 2: Click the word in the list so it is highlighted, then say or click Train. The Train Words window opens. 
Are you ready? (If you need to clear you throat, do it first!) Click Go, and read the prompt in your 

normal speaking voice, as if you were saying this word in the middle of a sentence.

Step 3: You may have to wait a second for this 
acoustic information to be incorporated -- be 
patient! Then you can say or click Done to 
close the Train Words window.

Reading Text to Train Dragon

Consider providing some reading for acoustic training after the first few days of practicing dictation: by then, 
speaking clearly into the microphone should be familiar, and reading aloud text presented by Dragon should 
better reflect how one actually dictates.

If your speech presents a particular challenge for speech recognition (due to a lisp or a strong accent for 
instance), you should perform a reading for acoustic training as soon as possible. 

Step 1: From the DragonBar’s Audio menu, click or say Read a text to improve accuracy. (You can also use the 
link in the Accuracy Center.) 

Step 2: When the Select Text window opens, choose a text to read, then click OK. The General Training 
window will open. Click Go to begin reading.
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IMPORTANT: Try to speak clearly but naturally and read exactly what is on the screen. If the software 
needs to hear you read something again, a yellow arrow will show you where to resume reading. If necessary, 
click Pause, then click Go when you are ready to resume.

Key points about acoustic training

In general, the best thing you can do to make Dragon recognize your speech even better is to use the �

software regularly, personalizing the Vocabulary (editing Spoken Forms or Word Properties as 

warranted, designating specific documents for Dragon to analyze, running or scheduling the Accuracy 
Tuning process…) and correcting misrecognitions as warranted. 

In certain cases (if a certain word is consistently misrecognized, or if overall accuracy is lower than you �

expected), you will want to provide Dragon some additional acoustic data.

You can train Vocabulary entries from the Vocabulary Editor (either one at time or several at once).�

When providing acoustic training, remember to speak as you typically do when you dictate to Dragon. �

It’s important to avoid the temptation to over-enunciate or speak loudly when training a word or 
phrase in isolation.

At any time, if you feel that the accuracy is not as high as usual, you can access Dragon’s Microphone ����

Check—through DragonBar’s Audio menu or the Accuracy Center, or by saying a command such as 
Check Audio.

You can improve the overall accuracy of your dictations by reading aloud one of Dragon’s acoustic �

training texts (you can go through the DragonBar’s Audio menu or the Accuracy Center). Consider 
reading at least one training text as soon as possible.
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Creating and Using Multiple Vocabularies
Every Dragon NaturallySpeaking user automatically has at least one Vocabulary. The Professional, Legal, and 
Medical editions of Dragon allow you to have several Vocabularies, although it is relatively rare for a person to 
need more than two or three. The advantage of having several Dragon vocabularies is being able to customize 
each one to perform best for very different topics or different styles of dictation. 

For instance, suppose an architect uses Dragon to dictate business letters and site reports, but also frequently 
uses it to write a newsletter for his community theater group. In his work-related dictation, he might use 
formal business language and mention technical terms and brands of construction materials. He might want to 
add the abbreviations for building codes, as well as the names of clients, contractors and other contacts he 
mentions in his work. When writing for his theater group, however, his dictation style might become 
significantly more casual and the words he uses most frequently would be different.

Having multiple Vocabularies helps achieve optimal accuracy in different dictation types. The documentation 
contains many details about creating and managing vocabularies. This lesson presents the essentials. 

Creating a New Vocabulary

Creating a new vocabulary is very similar to customizing 

your original vocabulary. It starts in the Manage 
Vocabularies dialog box.

Step 1: Say Manage Vocabularies or use the DragonBar’s 
Vocabulary menu 

Step 2: In the New Vocabulary window, choose a 
descriptive name and enter it in the Name field. 
From the drop-down list, choose the vocabulary 
on which you want your new vocabulary based 
(what you see in the list varies if you have the 
Legal edition of Dragon):

If you want to create a vocabulary which already contains the custom words from your existing •
vocabulary, choose this existing vocabulary from the list: e.g. General – Large.

If you want to create a vocabulary which does NOT contain any of the custom words from your •
existing vocabulary, choose the Base vocabulary. 

Step 3: Dragon will then offer to run the Vocabulary Optimizer. This automatic tool may take a while, and is 
not as powerful as the other vocabulary tools. Instead, you can choose Cancel, which exits the 

Vocabulary Optimizer. Then you can customize your new vocabulary using what you learned in previous 
lessons: Import a list of Words, Increase Accuracy From Email, Add Words From Documents… (see 
the Accuracy Center.)

Managing Multiple Vocabularies

After creating (or importing) a new Vocabulary, you may wish to rename or delete it; both are done in the 
Manage Vocabularies dialog box. 



Copyright  2011  Nuance Communications, Inc. All rights reserved 97

From there, you can also Export a Vocabulary (to burn it to a CD or save it to a USB drive, for instance). This 
would allow you to share it with other users; the recipient user would also access the Manage Vocabularies 
dialog, choose Import and browse for the exported Vocabulary’s .top file. (See the Help for more details.)

    

NOTE: If you have multiple Vocabularies for 
the same User profile, this will be reflected in 
the Open User Profile window, which will 
appear when you start Dragon. 

The Open User Profile window also shows the 
different dictation source(s) that may be 
available for the User profile(s) present on your 

computer. You can pick the line containing the 
Vocabulary (and, if application, User and 
Source) you wish to open. 

During your dictation session, you will be able 
to switch to a different Vocabulary, by saying 
open recent vocabulary, for instance.

Key points about multiple Vocabularies

If you dictate on two or more very different topics, using different customized Vocabularies will �

maximize your recognition accuracy. Each Vocabulary can be customized using the tools in the 
Accuracy Center—adapting to documents you designate, for instance.

If you have several Vocabularies, you will be prompted to choose one when you start Dragon. You can �

switch to a different Vocabulary later, by saying open recent Vocabulary, for instance.

The Manage Vocabularies dialog lets you create, delete, open, rename, import and export �

Vocabularies; it opens with the command manage Vocabularies (or from the Vocabulary menu).
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Acoustic and Language Model Optimization
Vocabulary customization and proper correction of recognition errors both help Dragon recognize your 
dictations more accurately. “Accuracy Tuning” is a functionality you can use to further “tune” your profile’s 
accuracy for your specific usage:

It refines your User profile using the latest acoustic data archived from any corrections and acoustic •
training you performed. 

It uses text extracted from your previous dictations to add frequent word sequences to the Language •
Model (Dragon’s statistical information that predicts which words are most likely to occur when you 
dictate).

IMPORTANT: If you have recently dictated in a very different sound environment, such as an airplane, you 

should not let Dragon perform acoustic optimization.

The Accuracy Tuning process becomes available once you have performed enough dictation, correction and 
training. Dragon will let you know once it has collected enough data for its automatic optimization.

The accuracy boost from Accuracy Tuning will depend on factors such as the amount and quality of the initial 
training and optimization (if performed during profile creation), the initial accuracy you experienced, and the 

amount and quality of text and audio data available for processing.

You can choose to schedule Accuracy Tuning to run periodically, at a time and frequency of your choice. You 
can also launch it, as shown below.

Launching the Acoustic and/or Language Model Optimization

Step 1: Use the DragonBar’s Audio menu (or, in the Accuracy Center, use the link “Launch Accuracy Tuning 
now”). 
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Step 2: Check the Acoustic and/or Language Model checkbox as desired, then click Go. (Note that Language 
Model optimization is typically much faster than Acoustic Optimization.)

Scheduling the Optimizations—and Data Collection

For convenience, Dragon lets you schedule a specific time and frequency for these optimizations. You can do 
this at the time you create your profile, and you can also do it later by going to the Administrative Settings 
dialog (available from the DragonBar’s Tools menu) and using its Scheduled Tasks tab.

IMPORTANT:  When you schedule a Dragon task, pick a time when your computer will be on (not 
sleeping, not hibernating), but Dragon will not be running (not even running in QuickStart mode).

The documentation contains details about how end-users and Administrators can access these optimizations 
and Dragon’s scheduling; the latest is available along with other Dragon documents on the Nuance website.  

In addition to Accuracy Tuning, you can choose to schedule another periodic task: the sending of anonymous 
usage data over the Internet to participate in the Data Collection which helps Nuance’s Research & 
Development team improve future releases of Dragon for all.
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The Data tab of the Options dialog. 

Note that it includes the setting for 
the frequency at which Dragon makes 
a backup of your profile (by default, 
Dragon does it every five times your 
profile is saved). 

Key points about Acoustic and Language Model Optimization

The Acoustic and Language Model Optimizer can automatically “tune” Dragon by making it review all �

the acoustic data and/or text data it has gathered from your usage. 

This Optimization can be launched at any time from the Audio menu or the Accuracy Center. It can also �

be scheduled so that Dragon performs it at a specific frequency and time.

When scheduling Accuracy Tuning (and Data Collection), pick a time when your computer will be on, �

but Dragon will not be running (this includes running in its QuickStart mode).
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Copying User Profiles
As you learned, each person who uses Dragon NaturallySpeaking creates a User profile, which the software 
holds in a set of files that contains, among other things, acoustic and lexical data. When you add a 
personalization to the Vocabulary (spoken form, alternate written form, capitalization property…), correct a 
recognition error, read a training text, or change an option, Dragon can save these changes in the open profile. 

Although Dragon automatically creates a profile backup (by default, every five times the profile is saved), it is 
a good idea to keep your own record of customizations, by exporting your custom words for instance, or noting 
what options or Properties you have changed…  

You can also copy your whole profile—for safe-keeping, or to make it available on another computer. Copying is 
a simple two-part process accomplished through the Manage User Profiles dialog box.

Step 1: Say manage user profiles (or choose Manage User Profiles in the Profile menu). In the Manage User 
Profiles dialog, select your profile, then choose Advanced > Export. (You may see a message about 
saving changes to the current profile.)

Step 2: A Browse dialog opens. Choose a destination (if you wish, make a new folder) then click OK. 

If both computers are on a network with a shared drive, this drive is probably the easiest location. 
Otherwise, you can export your profile to a media storage device, such as a portable USB drive.  

Now that your User profile is exported, it can be imported: 

Step 1: From the second computer, open the Manage User Profiles 
dialog. Choose Advanced> Import.

Step 2: When the Browse window opens, locate the folder containing 
the exported profile (this folder bears your profile’s name). 
Once it is highlighted, click OK.

Key points about exporting and copying User profiles

You must export the profile from the original computer, then import it to the recipient computer.�

Exporting and importing profiles is done through the Manage User Profiles dialog box—available through �

the DragonBar’s Profile menu or by saying manage user profiles.

The documentation contains more information about managing User profiles: deleting, renaming, backing up, 
restoring…  See for instance topics on Dragon’s Roaming User feature (available in Professional and higher 
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editions), which presents administrative advantages and is particularly useful for people who frequently dictate 
from different PCs connected to the same network.
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Practice Exercise: Creating a Memo by Voice
Bring up DragonPad or your usual word processor.  Using your new dictation and formatting skills, try to create 
the following document entirely by voice. After you have created the sample signature block shown in the 
sample below, replace it with your own information. 

Take this opportunity to practice looking up keywords in the Help to find out more ways to accomplish a 

particular task. Remember that you can use the Sidebar and the command “search Dragon Help for…”

August 5, 2009

AnyCorporation

Gene Hansen-Wolffe

P.O. Box 3299

Minneapolis, MN 67811-3299

Dear Gene,

I am pleased to report that my team has reviewed the Western Region Report for this quarter. As 
of July 29, 2009: 

the total is $875,500.

Please let me know your projected figures for the rest of Q3. 

As always, don’t hesitate to contact me at the number below.

Sincerely,

Sara Petersen

Regional Sales Manager

My Company, Inc.

202-965-5000

mobile: 715-377-1925

fax: 800-968-2231

sara.petersen@mycompany.com
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What’s New in Version 11?

Ellipsis (dot dot dot) triggers capitalization of the following word

You can modify this default through the Vocabulary Editor’s Properties button. If your usage of ellipsis is mostly for the end of 
sentences (as opposed to within a sentence), you can keep this default; to handle the cases when you do NOT want the ellipsis to 
trigger capitalization, you can say “no caps” right after the ellipsis. 

Spoken forms do not allow punctuation

See examples in the Vocabulary Editor and the workbook.

Dictation commands (such as “cap” and “caps on”) are now lowercase

This can matter for users who create or modify custom commands that refer to dictation commands, in HeardWord statements for 
instance. See the top of the Vocabulary Editor.

The DragonBar, its icons and menus

The DragonBar is designed to help you discover and quickly access important tools. In addition, it keeps important status indicators 
close together: microphone status, the Text Control indicator, the Recognition Mode indicator, and messages from Dragon. 

Full Text Control (formerly called "Select-and-Say"): The Text Control Indicator shows you the level of dictation support you can 
expect for the text field where you currently have your cursor. In Microsoft Word or DragonPad, for instance, Dragon has Full Text 
Control so the DragonBar shows a green checkmark (previous versions used a green ball). By contrast, where Dragon has only Basic 
Text Control, such as in PowerPoint and Firefox, the checkmark is gray (previous versions used a gray ball). 

The DragonBar now includes an icon indicating whether Dragon is in Normal, Dictation, Command, Numbers, or Spell Mode.

The menus are restructured provide easier access to important features. The former NaturallySpeaking menu is now called Profile; it 
contains only items related to your profile, including Backup and Restore. The Words menu is now Vocabulary and only includes 
Vocabulary-related features. The Accuracy Center has moved to the Help menu, under "Improve My Accuracy."

Dragon 11 menu name Pre-11 menu name

Profile NaturallySpeaking

Tools Tools

Vocabulary Words

Modes Words

Audio Sound

Help (includes Accuracy Center) Help

Note: To access the DragonBar menus by voice, say "Switch to DragonBar" then the menu name. Once a menu is open, you can open 
any of its items by saying its name.

Dragon's control menu, accessible by clicking the Dragon logo to the left of the microphone icon, provides clearer choices (Docked to 
Bottom, Floating…) and direct access to the Dragon Options. The former "Close" choice is now labeled "Exit Dragon."

New Results Display, and the former Results Box

When dictating, there’s no need to wait for Dragon to “catch up” with you — dictating in long phrases allows Dragon to transcribe 
more accurately than dictating slowly and with numerous hesitations. As you speak, Dragon 11 indicates that it is processing by 
displaying a small Dragon logo at your insertion point, and when you pause, your dictated words appear in your document. Our 
research shows that this enables many users to dictate better, without being distracted by seeing the preliminary results 
accumulating in the Results Box, as in previous versions. The traditional Results Box is still available from the View tab of the Options 
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dialog box. 

New Sidebar displays commands and tips

An enhancement of the former Sample Commands window, the Dragon Sidebar provides important commands and tips at any time. 
You can dock it on the left or right side of the screen, set it to auto-hide, or set it to "float" like other windows, place it anywhere, 
and more. The Sidebar's top pane contains commands, including a tab for mouse commands, and the lower pane contains tips. By 
right-clicking the Sidebar, you can display a menu to print the content, hide the Mouse tab or Tips pane, or switch to another 
monitor. The Sidebar’s content depends on which application currently has focus.

Accuracy Center is now more informative, includes links to Dragon Options and Auto-Formatting Options.

Redesigned Help and Tutorial 

You can now launch a search in Dragon's Help at any time by saying "Search Dragon Help for <words>," where <words> represent your 
search string. Dragon opens its Help window and displays your search results.

Correct or format multiple instances of text

Now when you tell Dragon to select, correct, or format text, if there are multiple instances of the text, Dragon displays a number 
next to each instance. You can then choose to apply the command to one or all.

Improved switching between programs and windows

When you need to switch between windows, you can ask Dragon to display a numbered list so you can indicate your choice without 
needing to know the exact name of the program or document. To display a list of open windows, you can say "List all windows." To 
show a list of open windows for just one program, you can say "List windows for Microsoft Word." 

“Require "Click"” avoids unintentional actions on HTML pages 

The "Require Click" option is on by default for hyperlinks in Dragon 11. You must say "Click" before saying the name of a hyperlink, or 
part of the name. For example, on a Web page with a link for "Directions to our office," you could say "Click our office." 

Scrolling commands in Internet Explorer, Mozilla Firefox, and Microsoft Word. 

New commands in the Spelling window (formerly called the Spell dialog box)

"Modify <1-9 >" and "Edit <1-9 >," work like the command "Select <1-9>" (you can use them to designate an almost-correct choice so 
you can modify it.

Display search text before performing searches

In Dragon 10, the Web search commands executed the search automatically. In Dragon 11, you can edit the search string before it is 
sent to your browser. The new Edit Search Keywords dialog box provides the option to correct, revise, or augment what you said in 
your command. The option is on by default.

Direct searches for more Web sites: "Search <site> for <word(s)>" includes Facebook, Twitter, Bing, MySpace, and IRS.gov.

Administrative Settings menu is always available 

Dragon now keeps the Administrative Settings available from the DragonBar's Tools menu, even when you have a User Profile open. 
The Administrative Settings dialog box contains important items, such as scheduling automatic Accuracy Tuning and choosing a 
custom backup location – plus, in Windows XP, the disabling of ctfmon.exe, a program which can interfere with Dragon.

Command Browser interface

Dragon 11 includes enhancements to the Command Browser that make it faster to use filter the display of commands by keywords. 
Also, to shorten the list of commands displayed for specific contexts, Global Commands are omitted by default. You can easily 
include them in the list by selecting the check box for "Include Global" on the Command Browser toolbar.

Improved recognition when multiple processors are available

Dragon now automatically detects computers with multiple processors and at least 2 GB of RAM, improving recognition by working 
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with this hardware. See Advanced - Choose Models for details about Advanced settings.

Don't Recognize That Word

Dragon now enables you, right from the Correction Menu, to prevent certain words from being recognized. For example, if you 
dictate the name "Cassity" often and Dragon always hears "Cassidy," you can use Don't Recognize That Word on Cassidy.

Audio-quality alerts

Many misrecognitions are actually caused by poor audio input. To ensure that it receives the highest quality audio, Dragon 11 detects 
drops in audio quality and reminds you of typical causes, including microphone placement, excessive background noise, or if your 
Bluetooth microphone battery is low. Dragon alerts you in various ways, depending on the severity of the problem.

Improved command and control

It's faster and easier to perform tasks such as opening applications and switching to a particular window, and  Dragon 11 contains 
commands for Windows itself, such as showing the Desktop, Control Panel, or folders such as My Documents and My Pictures. See 
Windows Desktop commands for details.

Support for Microsoft Office 2010 (32-bit and 64-bit)

Dragon 11 provides compatibility with Microsoft Office 2010, including Full Text Control and Natural Language Commands. See Using 
the Microsoft Office ribbon for details.

Reduced memory usage during acoustic optimization

Dragon 11 uses significantly less memory than previous versions during optimization. Running the Acoustic Optimizer regularly is 
important for improving your User Profile’s accuracy over time, and it is easier to do in Dragon 11.

Support for OpenOffice.org Writer

Dragon 11 provides Full Text Control for OpenOffice.org Writer. At any time, you can use commands like "correct <xyz>" and "insert 
after <xyz>.”

Easier names for popular programs

Dragon now recognizes shorter names for popular Windows programs. For example, now you can say "Open Microsoft Word" rather 
than "Open Microsoft Office Word 2007." 

Shift Ctrl mouse click voice commands

Dragon provides new voice commands for pressing the Shift and Ctrl keys by voice in conjunction with right or left clicking the mouse. 
These options provide greater flexibility with certain Windows programs.

More file formats for use with digital recorders

Playback options added to the Text-to-Speech Options: control playback/rewind/fast forward speed (in %) and volume (in %). 

Recognition History shows commands and timestamps 

The Recognition History window displays the utterances Dragon recognized in the current session. It now shows which utterances 
were recognized as commands, and provides a timestamp for all utterances. You can also store recognition history information in text 
files, which may be useful if you need to contact Support. 
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Command Browser, 10, 12, 52, 57, 59, 62, 65, 69, 70, 
74, 80, 81, 82, 83, 84
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price, 38
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recorders, 2, 3, 8, 45

Results Display and Results Box, 34

Resume with, 53

Ribbon, 61, 71, 72

Roaming, 47, 48, 93

Sleep, 30

Sound Recorder, 1

Speed, iv, 6, 7

Spell Command, 40

Spelling window, 42, 43, 44, 46

Text Control (Select-and-Say), 38, 51, 55, 76

titlebar, 28, 30
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tray, 30

Tutorial, 2, 6, 9, 62
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